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Lesson 1
Explaining Routes

Upon successful completion of this lesson, you will:

Understand the basics of routing.

Understand the different types of routes.

Understand the various routing components and their roles.
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Introduction SolidWorks Routing is an advanced course, requiring a basic 
knowledge of various SolidWorks operations, including top-down 
design, general part design, use of configuration and design tables, 
drawing creation, etc.

This manual assumes this level of SolidWorks skills.  If you are new to 
SolidWorks it is recommended that you refer to the SolidWorks 
Essentials: Parts and Assemblies and SolidWorks Essentials: Drawings 
training manuals.  Please contact your reseller regarding these 
SolidWorks training courses.

Recommended 
Settings

It is recommended that you begin with the following options settings:
Tools, Options... 
System Options, Colors
Check Use specified colors when editing parts in assemblies
System Options, Display/Selection
Assembly transparency for in context edit set to Opaque 
assembly.
System Options, File Locations
Under Design Library, add the location c:\solidworks 2005 
training files\routing\training design 
library\routing\electrical\harnessing, and use Move 
Up to put it at the top of the list.

(NOTE: This is the default location for unpacking of the training files; 
adjust path if necessary.)
System Options, Routing
Set Library folder to 
c:\solidworks 2005 training files\
routing\training design library

(NOTE: This is the default location for unpacking of the training files; 
adjust path if necessary.)

Under Component and route defaults, check 
Automatically route on drop of clips
System Options, Large Assembly Mode
Under Display, uncheck Hide all planes, sketches, curves, ...

Check Preview when inserting new components
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Types of Routes SolidWorks Routing enables the designer to create tube, pipe and 
electrical (cable and wire) routes. Routes fall into several categories; 
some examples are below:

Soldered copper, PVC, flexible tubing, electrical wiring enclosure, 
welded piping, fabricated cable, and associated fittings.
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File Naming in 
Routing

The default naming convention for routing components is intended to 
be compatible with PDMWorks® and other PDM systems. As always, 
users may name files according to their own preference or company 
standard.

The default format for route sub-assemblies is:

RouteAssy#-<upper level assembly name>.sldasm

and for tube, pipe and cable parts within these route sub-assemblies:

Tube or Pipe (and configuration) or Cable-RouteAssy#-
<upper level assembly name>.sldprt.

Note There may be references in this manual that do not conform to this new 
convention.

Routes A Piping route is used in this 
description because it uses the most 
specialized components. 

The Route is a component of a 
routing Sub-assembly, including a 
3D Sketch, that describes the 
centerline path of the piping, tubing or 
cable / harness route from a starting 
connection to an end connection. The 
properties of the route includes 
information to set the pipe, tube or 
cable nominal size, schedule or gage, 
and default elbow.

External 
Components

Routes are Sub-assemblies 
that can be connected to 
external components such as 
tanks, cylinders, manifolds 
or various electrical 
components. The sub-
assembly component keeps 
the route components 
separate from the external 
components and other 
routes.
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Route 
Components

Using the route properties and sketch geometry, pipes and elbows are 
added. Based on the elbow locations and geometry, the lengths of pipe 
between them are determined and added as individual components. In 
this example all the pipes are purple; elbow and flange fittings are 
yellow and reducer fittings are red. 

Anywhere the Fabricated Pipe changes direction is considered an 
elbow and is generally represented in the sketch as an arc. The straight 
lengths are represented as lines. 

With rigid tubing, bends replace elbows. 

Flexible tubing (hose) and cable typically use spline shapes; it is 
unusual for there to be truly straight runs of these components.
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FeatureManager 
Listing

The FeatureManager for the Routing Sub-assembly lists the pipe and 
components used in the route. The component types used in this 
example are: pipes, flanges, elbows, reducers and custom elbows. One 
of each type is labelled graphically. 

Note The Route Components are attached to the route sketch directly and 
do not require mates to each other. Only the flange type, which 
connects to components outside the route, is mated.
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Individual 
Components

Many of the common piping components, both parts and assemblies, 
are supplied with the SolidWorks Design Library. You can create your 
own custom components and libraries.

Tubes are parts that follow the 
length of the route, to the end of 
the sketch or to a fitting. The part 
includes all bends whether they are 
orthogonal or free form.

Pipes, or more specifically 
Fabricated Pipes, are parts that 
are placed between elbows and 
fittings following the route. The 
FeatureManager listing includes 
the name, configuration and 
length.
Rigid copper tubing would be 
considered fabricated pipe.

Cables are parts that follow the 
length of the route, to the end of 
the sketch or to an electrical 
connector. Unlike Tubes and 
Pipes, there is no cable “seed” 
part; the cable is generated within 
the route, with specifications 
extracted from a default or user 
specified Microsoft Excel or XML 
file.

Standard Elbows are part 
components that are placed at 
changes in direction along the 
route. They are placed 
automatically at 90 and 45 degree 
bends. The FeatureManager listing 
includes the name and 
configuration.



SolidWorks 2005 Training Manual Lesson 1
Explaining Routes

Routes 13

Custom Elbows are used where 
the change in direction is less than 
90 degrees but not 45. The system 
will prompt you to allow the 
modification of a standard elbow 
to match the angle. The 
FeatureManager listing includes 
name, configuration and sizing.

Fittings is a general classification 
of part components that are not 
added to the route automatically 
like pipes and elbows. This 
includes tees, reducers and crosses.

Flanges and Connectors are 
special part fittings that generally 
connect to both the route and 
equipment outside the route. 
Because of this, flanges and 
connectors generally contain Mate 
References for equipment 
connections.

Assembly Fittings is a general 
classification of assembly 
components that are not added to 
the route automatically like pipes 
and elbows. These include valves, 
switches and other multiple-part 
route components.

Clips are routing components for 
electrical or flexible tubing routes 
that help to locate the route as 
desired. Clips can be pre-placed 
and used as reference locations, or 
dropped into the route “on the fly” 
during route generation.
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Lesson 2
Review of Configurations

Upon successful completion of this lesson, you will:

Understand how Routing and Design Library parts use 
configurations.

Understand the role of design tables.
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Review of 
Configurations

Configurations, specifically 
those created by Design Tables, 
are an integral part of Routing. 
They are used to create and store 
library parts such as tubes, pipes 
and elbows. For example, one 
part can be used to represent 
multiple tubes, each having 
different diameters and wall 
thicknesses. 

How Routing Uses 
Configurations

Routing uses configurations to select matching tubes or pipes and 
related components to size the route.

Tube/Pipe 
Components

When a tube/pipe route is started 
with a fitting such as a Flange, 
the configuration that represents a 
specific nominal diameter is 
selected. The pipe that connects to 
that fitting now has limited set of 
configurations to choose from 
based on that nominal diameter. 
The choices are limited to the type 
of pipe or the schedule in that 
diameter. 

The tube/pipe part is copied to the 
local folder and configurations are 
used to represent the required 
lengths.

That tube/pipe part is used 
throughout the route. Added 
components must match the 
sizing that has been selected for 
the route.

Note Electrical routes do not use configurations to determine route and 
component size.

Fittings Fitting configurations are chosen by 
matching the configuration of the tube/
pipe. If the fitting does not contain a 
matching configuration, an error is 
produced.

Unlike tubes and pipes, fitting parts are 
not copied to the local folder. They remain referenced to the Design 
Library.
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A Note About 
File References

Referenced files do not have to be stored with the document that 
references them. In most practical applications, the referenced 
documents are stored in multiple locations on the computer or network. 
SolidWorks provides several tools to determine the references that exist 
and their location.

Find References Find References provides the exact locations of referenced part and 
assembly files. Find References will display the Search Results dialog 
box which lists the component files used, including the full path names. 
This is useful if you have several versions of the component files.

Where to Find It From the File menu, select Find References.

Copy Files The Copy Files button can be used to copy the files to another, 
common, directory. Find references can be used as a “Pack and Go” by 
copying the parent and all referenced files to a single location. This can 
be useful when creating a ZIP file with a drawing, assembly and all the 
parts.

File Management As noted previously, pipe and tube parts are copied and saved in the 
working directory with only the required configurations. Fitting parts 
are not copied, so the assembly will reference the file in the Design 
Library directory.

If the entire assembly is to be copied, moved, archived or zipped, 
consider saving all the reference files (Design Library parts) with it. 
Find References will accomplish this.

It is also a good idea to include a copy of the original pipe or tube file 
from the Design Library with the assembly. In this way, should a new 
pipe or tube route of the same type be added to the assembly after it has 
been moved, the same seed part can be used.

The configured pipe or tube files that exist in the assembly do not have 
all the required information to be used in a new route and hence cannot 
be used this way. Find References will NOT copy this file, it must be 
done manually.

PDMWorks® SolidWorks Office Professional includes PDMWorks®, which provides 
a powerful way to manage library parts and project files.

For more information, see the File Management training manual.
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How Libraries Use 
Configurations

Library Parts are supplied by SolidWorks through the Design Library. 
These parts and assemblies, as required, use design tables as the engine 
to create configurations. Design tables can set the values for 
dimensions and suppress features by configuration name. The result of 
the design table is a set of configurations shown in the Configuration 
Manager. 

Design Tables Design tables are the most efficient method of creating and maintaining 
configurations. Using an Excel spreadsheet, the configurations and the 
variations between them are recorded and stored.

The Design Table contains columns for configurations, dimension 
values, suppression of features, configuration specific properties and 
notes. Using the Auto-create function allows the table to be generated 
automatically from the input.
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Design Table Input 
and Output

The input options include the parameters dimensions, features and 
properties. The output is a set of configurations that are added to the 
ConfigurationManager of the part. As always, descriptive names 
should be used for dimensions and features included in the design table.

If the design table settings allow it, changes can be bi-directional.
Dimension Values
A Dimension Name appended with $<feature name> as a 
column header controls the value of that dimension by 
configuration. 
Feature Suppression
Prefixing a Feature Name with $STATE@ allows that feature to be 
suppressed or unsuppressed by configuration. Suppress, S, 
Unsuppress or U appear in the cells below the header. A blank 
cell assumes unsuppress.
Configuration Specific Properties
Properties added to the part through File, Properties 
Configuration Specific tab appear in the design table with the 
prefix $PRP.
Notes
User defined notes can be added in rows or columns with 
$USER_NOTES as the row or column header.
Configuration Names
Configuration names added in the header row become 
configurations that appear in the ConfigurationManager.
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Lesson 3
Top Down Design

Upon successful completion of this lesson, you will:

Understand the basics of top down assembly design.

Understand the function and mode of commands for editing of parts 
and sub-assemblies in context of the top level assembly.
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Top Down 
Introduction

Top Down Assembly modeling involves the switching between the 
editing of parts and assemblies.

1 Open assembly.
Open the assembly Equipment 
Assembly.

Parts and 
Assemblies

When using routing, several types of components are used. Each can be 
edited in turn to make effective use of top down design and complete 
the routing assembly. The types of components are labelled below.

Note that the sub-
assembly in this 
case is a specific 
type, a Routing sub-
assembly.

Edit Part While you are in an assembly, you can switch 
between editing the assembly — adding mate 
relations, inserting components, etc. — and 
editing a specific part. Editing a part while in 
the context of an assembly allows you to take 
advantage of geometry and dimensions of 
other components while creating matching or 
related features. Using geometry outside the 
part creates External References and In-context Features.

Four commands, Edit Part, Edit Assembly, Edit Sub-assembly and 
Edit Route are used to switch back and forth between editing one 
component in an assembly and editing the assembly itself. When you 
are in edit part mode, you have access to all the commands and 
functionality the part modeling portion of SolidWorks. Plus, you have 
access to other geometry in the assembly. 

Top Level Assembly

Sub-assembly

Part
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Introducing: 
Edit Part, 
Edit Assembly and 
Edit Sub-assembly

Edit Part/Edit Assembly/Edit Sub-assembly is used to switch 
between editing a part and an assembly. The right-mouse menu will 
display the proper command.

Where to Find It Select the part or sub-assembly you wish to edit. Then:

Click Edit, Part, or Edit, Assembly or Edit, Sub-assembly.
Or, from the right-mouse menu, select Edit Part, Edit Assembly or 
Edit Sub-assembly.
Or, from the Assembly toolbar, click the  tool.

Note The colors are set through Tools, Options, System Options, Colors 
as Assembly, Edit Part and Assembly, Non-Edit Parts. In order to 
see these colors, the option Use specified colors when editing parts 
in assemblies must be enabled. Otherwise, the edited part’s color will 
not change. This option is unchecked by default.

Appearance of 
Components While 
Editing

When you edit a part in the context of the assembly, if the option above 
is turned on, the component you selected turns opaque pink (or any 
user-specified color). The appearance of the other components depends 
on the assembly transparency settings you choose.

Introducing 
Change Assembly 
Transparency

The transparency of components that are not being edited can be set to 
one of three conditions:

Opaque assembly. All components 
become opaque gray, except for the 
component you are editing, which 
becomes opaque pink (recommended, 
particularly for complex designs.)
Maintain assembly transparency. All 
components maintain whatever their 
current transparency is, except for the 
one you are editing, which becomes 
opaque pink.
Force assembly transparency. All 
components become transparent except 
the one you are editing, which becomes 
opaque pink.

Where to Find It From the menu click Tools, Options, System Options, Display/
Selection, Assembly transparency for in context edit....
Or, from the Assembly toolbar, click the  tool.

Note Use the slider to adjust the transparency level for Force assembly 
transparency. When you move the slider to the right, the components 
become more transparent.
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Editing Options Each editing option is useful in its own way in the assembly context. 
By editing parts in context, you can take advantage of any entity in the 
assembly for sketching, offsetting, converting and dimensioning.

Edit Assembly Edit Assembly is the default 
state of an assembly when it is 
created or opened. 

Also, when Edit Part or Edit 
Sub-assembly is “turned off” 
the top level assembly returns 
to this state.

Use Edit Assembly to:

Add or delete components 
from the top level 
assembly.
Add or delete mates from 
the top level assembly. 

Edit Part Edit Part is used to access a 
specific part and edit it while 
remaining in the top level 
assembly. 

Use Edit Part to:

Add or edit individual 
sketches of a part within 
the assembly.
Add or edit features of a 
part within the assembly.
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Edit Sub-assembly Edit Sub-assembly is used to 
access a sub-assembly and edit 
it while remaining in the top 
level assembly. In routing it is 
often used to make changes to 
the route sub-assembly . 

Use Edit Sub-assembly to:

Add or delete components 
within the sub-assembly.
Add or delete mates within 
the sub-assembly.

Edit Route Edit Route is used to edit the 
3D Sketch that defines the tube 
or pipe route. This 
automatically switches to Edit 
Sub-assembly mode using the 
route sub-assembly. 

Use Edit Route to:

Create and edit the 3D 
Sketch used as the route.
Add inline components 
such as reducers and tees.

Assembly Feature An Assembly Feature is used 
to add a cut feature or hole to 
the top level assembly. The 
feature uses a Feature Scope 
to determine which 
components are affected by the 
cut.

Use Assembly Feature to:

Add a cut feature that exists 
only in the top level 
assembly.
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Lesson 4
Design Library Introduction

Upon successful completion of this lesson, you will:

Understand how Design Library parts are used in Routing.

Understand the function of Routing Points in Design Library parts.

Understand the Configuration Specific Properties required for 
Routing components.
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Design Library 
Parts 
Introduction

Design Library Parts are standard components of various types that can 
be stored on the Part Design Library for insertion into an assembly 
quickly and easily. SolidWorks supplies some, but users may also make 
their own.

The Design Library parts supplied with the SolidWorks software are 
configured with established standard sizes. They include some standard 
fasteners and mechanical components, but in this case we will work 
with standard pipe, tube and electrical components.

There are both geometric and non-geometric (property) requirements in 
building design library parts.

Routing Points There are specific geometric requirements for Design Library parts 
including the Route Point and Connection Point features. 

Note Route Points (RPoint) and Connection Points (CPoint) are 
collectively referred to as Routing Points.

Connection Points Connection Points are 
required in fittings and 
electrical connectors such as 
elbows, tees, crosses and crimp 
terminals. They are used to 
determine where the routing 
ends and the direction that it 
enters the fitting or connector.

They are also used to specify 
the nominal diameter of the 
route and the type of route: 
Electrical, Tubing or 
Fabricated Piping.
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Tip Double-clicking a CPoint 
displays the nominal diameter 
assigned to the CPoint.

In an Electrical route, the 
nominal diameter is defined as 
a maximum cable size for that 
component.

Route Points Route Points are required in 
fittings such as elbows, tees, 
crosses and route clips. They 
are used to place the fitting on 
an endpoint on the 3D Sketch 
route line, or in the case of 
clips, to help define the path of 
of a flexible route.

Tip Route line components (tube, fabricated pipe, or electrical cable) do not 
have routing points in them.

Libraries SolidWorks provides Design Library parts and assemblies that include 
common tube, wiring and pipe sizes and associated fittings.

For more vendor-supplied routing components, visit 
3DContentCentralSM, www.3dcontentcentral.com.
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Tubing C:\Program Files\SolidWorks2005\data\design 

library\routing\tubing

Tubes tube-ss

Flanges slip on tube 
flange-ss

Tube Fittings 
(Connectors)

solidworks
-lok male 
pipe weld 
connector

solidworks
-lok male 
connector

Tube Fittings 
(Tees)

solidworks
-lok tubing 
branch tee

solidworks
-lok male 
branch tee

tee-ss
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Threaded 
Piping

C:\Program Files\SolidWorks2005\data\design 
library\routing\piping\threaded fittings (npt) 

Pipes threaded 
steel pipe

Elbows threaded 
elbow--
45deg

threaded 
elbow--
90deg

Tees, Laterals 
and Crosses

threaded 
tee

threaded 
lateral

threaded 
cross

Couplings and 
Unions

threaded 
coupling

threaded 
half-

coupling

threaded 
union

Reducers and 
Cap

threaded 
reducer

threaded 
cap
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Piping C:\Program Files\SolidWorks2005\data\design 

library\routing\piping

Pipes Pipe

45° Elbows 45° LR Inch 45° LR 
Metric

90° Elbows 90° LR Inch 90° LR 
Metric

90° SR Inch 90° 3R Inch

Tees Reducing 
Outlet Tee 

Inch

Straight 
Tee Inch

Flanges Socket Weld 
Flange

Slip On Weld 
Flange

Welding 
Neck Flange
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Crosses Straight 
Cross Inch

Reducing 
Outlet 

Cross Inch

Straight 
Cross 
Metric

Reducers Reducer Eccentric 
Reducer

Piping C:\Program Files\SolidWorks2005\data\design 

library\routing\piping

Assemblies C:\Program Files\SolidWorks2005\data\design 

library\routing\assembly fittings

assembly 
fitting

assembly 
fitting 

without acp

Valves 2in control 
valve
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Electrical C:\Program Files\SolidWorks2005\data\design 

library\routing\electrical

Ring Crimp 
Terminals

ring_term_
awg-14-

16_awg-x 8

ring_term_
18-22_awg-

x_6

DIN 
Connectors

socket-
6pinmindin

plug-6pin-
minidin

plug-
5pindin

USB Plugs plug-usb1 plug-usb2

DB 
Connectors

db9 male db15-e

Clips pclip2 richco_
hurc-4-01-

clip

richco_
dhurc-4-01
-dualclip

cable
constraint

(no visible 
geometry)

Other plug-sma
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“Pipe” Parts The classification of “Pipe” parts includes tubes as well as true 
fabricated pipes and elbows.

Note Unless otherwise specified, these properties apply to tubing and piping 
only, not to electrical components.

Design Table 
Parameters

All Design Library pipe parts require design tables to store the required 
information: 

$PRP@Pipe Identifier
InnerDiameter@PipeSketch or @FilterSketch
OuterDiameter@PipeSketch or @FilterSketch
NominalDiameter@FilterSketch

Certain other components may use these parameters to size themselves 
accordingly when dropped into an assembly. These include pipe elbows 
and pipe and electrical hangers/clips such as pclip2 (Nominal, Inner 
and Outer Diameters).

Electrical wire and cable use only the 
OuterDiameter@PipeSketch parameter. Data for wire and cable 
parts are stored in a .XML file; There is no Design Library part.

Configuration Name The Configuration Name is used in the Route Properties dialog as 
the Base Configuration.

Configuration 
Specific Properties

The Pipe Identifier property is required for the component to be 
recognized as a tube or pipe. The property is entered as a 
Configuration Specific Property through the File, Properties dialog 
as $PRP@Pipe Identifier. The value of this property is used to 
name all instances of the tube or pipe in the route.

Other properties can also be added as descriptions or additions to a 
BOM table. Properties such as Description, Weightperfoot, 
Wall Thickness and Swbompartno are common additions.

Dimensions The InnerDiameter, OuterDiameter dimensions are taken 
from the PipeSketch sketch of the Extrude or Sweep feature. 
The NominalDiameter is taken from the FilterSketch sketch.

Additional dimensions can be added for use in equations or 
descriptions.

Note The length of each tube or pipe segment is extracted for use in the 
BOM table.
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Lesson 5
Design Library Review

Upon successful completion of this lesson, you will:

Understand the function of the Design Library: Features, Parts and 
Assemblies.

Be able to organize Design Library components.

Understand the options available for Routing.



Lesson 5 SolidWorks 2005 Training Manual
Design Library Review

38



SolidWorks 2005 Training Manual Lesson 5
Design Library Review

Design Library Task Pane 39

Design Library 
Task Pane

The Design Library pane is used to access and store commonly used 
library features, sheet metal forming tools and parts. Design Library 
parts can be added to an assembly by simply dragging and dropping 
them into that assembly. Mate Relations, SmartMates and Route Points 
are used to position the part.

Introducing: Design 
Library

The Design Library Task Pane tab  is a 
menu set devoted to the storage and easy 
retrieval of library features, forming tools, 
assemblies, and piece parts. It is designed to 
resembly Windows Explorer in apprearance 
and function.

Navigation through the directory structure is by 
single (select and view)and double (open) 
click.

Reload  refreshes the window with 
changes that have been made to the folder since 
it was opened.

Where to Find It On the Task Pane, select the Design Library .

Essentials of 
Using the Design 
Library Task Pane 

Taking full advantage of the Design Library pane requires an 
understanding of the file structure it uses. Although some library 
features and parts are supplied with the SolidWorks software, the real 
power of the Design Library is in creating and using your own folders 
and libraries.

Directory 
Structure

These files can be located on 
your hard drive using Windows 
Explorer by browsing to the 
Solidworks install folder 
and opening the data\
design library folder. 
This folder contains five main 
folders for the Design Library 
pane: assemblies, 
features, forming 
tools, parts, and 
routing.

Note: The view in the Design 
Library pane is virtually 
identical to that in Windows 
Explorer.

Library Features

Forming Tools

Library Parts

Library Assemblies

Routing Components
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Library Parts Parts shipped with the Design Library are found 
in the subdirectories located under the folder 
parts. Each folder creates a corresponding 
folder in the Design Library pane. All of these 
must be *.sldprt files.

Library Assemblies Assemblies shipped with the Design Library are 
found in the subdirectories located under the 
folder assemblies. These must be 
*.sldasm files.

Adding to the 
Folders

You can add any library feature, part or assembly to these folders, 
either using the Design Library panes or Windows Explorer, and they 
will appear in the Design Library lower pane. They will appear as icons 
showing their preview pictures.

You can drag and drop files onto the Design Library pane from the 
open file or from Windows Explorer. Press the Delete key to remove 
them from the Design Library.

Sub-folders and 
Panes

Each sub-folder, such as threaded 
fittings (npt), holds the appropriate 
type of files (*.sldprt in this case). The 
folder name appears in the Design Library 
upper pane. The folders and files 
themselves appear as icons in the lower 
pane (similar to the left-right relationship in 
Windows Explorer).

You can also add your own sub-folders in 
any of the directories. These will appear as 
folders in the Design Library pane.

Icons The graphics of the icon are taken automatically from the 
last saved image of the library feature or part. They can be 
shaded or wireframe images, but you should zoom in on 
them for the best results.

The name of the icon comes from the name of the library feature, part 
or assembly as it appears within the folder. It can be changed by 
clicking on it.
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Organizing Your 
Libraries

You can control where the SolidWorks software looks for your libraries 
by setting a search path in Tools, Options, System Options, File 
Locations, Design Library.

Note See “Before You Begin...” at the beginning of Lesson 7, regarding 
adding the Training Design Library location.

Folders In the Folders list you can set search paths for many files that 
SolidWorks references. A partial list is given below. For a complete 
list, refer to the online help.

Library parts, assemblies, features, and forming tools .
Color swatches, material databases and textures.
Document templates, referenced documents, sheet formats.
Blocks, BOM templates, hole callout format files, and dimension 
favorites.
Macros, journal files and macro feature files.

Several paths can be set for each category. If you have more than one 
path, the system searches them in the order they are listed.
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Routing Options Options that are specific to Routing can be found in the Tools, 
Options, System Options, Routing.

Library folder path - Similar to the 
Design Library location in File 
Locations, this is the default routing 
component location. It may be the 
same as a Design Library location, or 
can be a different folder. This location 
will appear in the Route Properties 
dialog and may be edited there as well. 

Note It is important to set this path to the Training Design Library before 
beginning the case studies in Lessons 7 and 8.

Create custom fittings - Automatically creates custom 
configurations of the default elbow fitting when needed.
Create pipes on open line segments - Generates a pipe for 3D 
sketch segments that are connected to a fitting at only one end.
Automatically create sketch fillets - Automatically add fillets at 
intersections as you sketch.
Automatically route on drop of clips - Will auto-route a flexible 
tube or cable through a properly configured route clip when it is 
dropped from the Design Library.
Enable minimum bend radius check - For electrical cables only. 
Reports an error if the bend radius of an arc or spline in the route is 
less than the minimum specified for the cable in the cable library. 
Enable minimum bend radius check for wires - For electrical 
cables / wires / harnesses only. Reports an error if the bend radius of 
an arc or spline in the route is less than the minimum specified for 
the individual wire or cable core in the cable library. If there are 
many wires in the assembly, this option might result in slower 
performance.
Connection and route points text size - Scales text for 
connection and route points to a fraction of the document's Note 
font.
Slack Percentage - For electrical routes only. Calculated cable 
lengths are increased by the stated percentage to compensate for 
sag in flexible routes caused by gravity.
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Lesson 6
3D Sketching Review

Upon successful completion of this lesson, you will be able to:

Create a 3D Sketch.

Use the orthogonal method to sketch using standard planes.

Use the selected plane method to sketch using user defined planes 
and planar faces.

Use the spline tool to create a freeform route line.
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3D Sketching A 3D Sketch is a sketch that allows you to create geometry in any 
plane or planar face. In routing, it is used to define the path followed by 
the tube, pipe or cable.

Orientation changes 
during sketching are 
provided by the Space 
Handles, a set of red 
axes that show the current 
directions as you sketch. 
The Tab key is used to 
toggle from the default 
Front axes to those of 
the Right and Top 
planes.

Space Handles The Space Handles are a set of axes that can be changed on the fly 
while sketching. When the Line tool is selected, a set of axes appear 
with the line as it is sketched. These axes are parallel to those of the 
Front reference plane and allow sketching along those axes or within 
the plane. Two other planes can be accessed through the Tab key. 

Note Regardless of the plane used, the axis labels refer to the axes of the 
Front plane (X, Y and Z).

Local Horizontal 
Axis

Local Vertical Axis Local Plane

Front
(Initial plane)

Right
(Tab once)

Top
(Tab twice)
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1 Open part.
Open the part 3D 
Sketch Example. The 
part contains two visible 
sketches that will be used 
as connection points.

Orthogonal 3D 
Sketching

Using the standard three planes for sketching allows you to sketch 
along the X, Y and Z axes of the Front plane. You can also sketch on 
any plane formed by a pair of the axes.

Where to Find It Click  from the Sketch toolbar.
Click Insert, 3D Sketch.

2 New 3D Sketch.

Click 3D Sketch  to open a new 3D Sketch.
3 Along X Axis.

Clicking the Line tool and start a new line at the 
upper point and drag the other end of the line. 
Position along the axis until the X label appears 
indicating that the line is on the X axis. Extend the 
line as shown.

4 Using the Space Handles.
Begin the next line at the open endpoint and 
drag the line. Press the Tab key to orient the 
Space Handles to the orientation shown. Drag 
the line along the Y axis. Locate the end of the 
line roughly as shown. 

5 Along Y Axis.
Using the same 
set of axes, 
sketch a line 
along the Y axis 
followed by the 
Z axis.
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6 Coincident.
Add a Coincident 
relation between the open 
endpoint and the left 
most point in the sketch.

7 Dimension.
Add a dimension 
between the vertical line 
and endpoint as shown. 
Set the value to 13.75”.

8 Fillets.
Add fillets of radius 1” to 
the corner endpoints.

Tip 3D Sketches offer a few more relations than a standard sketch. They are 
ParallelYZ, ParallelZX and AlongZ and refer to the planes and axes of 
the sketch.

9 Exit the sketch.
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Sketching on 
Selected Planes

3D Sketching can use planes other than the standard Top, Front and 
Right. An alternative plane or planar face can be selected by Control-
clicking it while sketching. This process activates a set of Space 
Handles with the X and Y axes parallel to the selected plane. Two other 
sets of axes (rotations of the first) are also available through the Tab 
key.

Note Performing this process during Routing (Edit Route) requires only a 
selection without the Control key.

1 Show Plane.
Right-click the reference plane Angle_25 and select Show. Click 

Select  to turn off highlighting of the plane.

2 Along X axis.
Create a new 3D Sketch. 
Sketch a line starting on 
the middle point and 
running along the X axis 
as shown.

3 Switch Plane Reference.
Control-select the plane Angle_25 from the Flyout 
FeatureManager design tree. 
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4 Along Plane.
Sketch along the X axis 
of the Angle_25 plane 
as shown. 

5 Return to Standard Planes.
Control-click the Front plane to return to the standard 
plane selections. 

6 Along Z.
Use the Tab key to switch 
to the plane orientation 
shown. Sketch along the 
Z axis. 

Continue along the Y and 
Z axes to complete the 
lines.

Add a Coincident 
relation to tie the 
endpoint to the sketch 
point.
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7 Dimensions.
Add the dimensions 5” 
and 8” as shown. Also 
add radius 1” fillets.

Close the sketch.

Spline The 3D Sketch can be used to represent a “flexible” path between 
connection points. This method uses Spline to form smooth 3D curve 
between lines. The lines remain to help shape the spline.

Note This type of sketch can not be used with piping.

1 Starting Line.
Create a new 3D 
Sketch. Sketch a line 
starting at the lower 
left sketch point along 
the X axis.

2 Ending Line.
Create a second line 
starting at the center 
sketch point along the Z 
axis.

Spline Spline is used to form a shape that is more free-form than orthogonal 
segments. The spline can be set to be tangent to straight segments.

Where to Find It Click  from the Sketch toolbar. 
Click Tools, Sketch Entities, Spline.
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3 Spline.
Click Spline, then click one of 
the straight segment endpoints. 
Drag the shape toward the 
other endpoint.

You can use either click-click 
or click-drag method.

Note You can add intermediate spline points, by clicking the left mouse 
button, to help form the desired shape. 

4 End the Spline.
Click on the endpoint of the 
other line segment to finish the 
spline. Right-click and choose 
End spline.

Add Tangent relations 
between the spline curve and 
each of the straight segments.

The spline can also be shaped 
by dragging the endpoints, or 
adding intermediate spline 
points after creation.

Note When using a spline in routing, the tangent relations are added 
automatically.
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Lesson 7
Tubing Routes

Upon successful completion of this lesson, you will be able to:

Route flexible tubing using the spline tool.

Route rigid tubing using 3D orthogonal sketching.

Using Auto Route for both rigid and flexible tubing.
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Tubing Routes Tubing Routes use tube parts shaped by 3D Sketches to form sub-
assemblies that contain tubes and fittings. The tube can be shaped 
orthogonally (rigid tube) or flexibly (hose or malleable tube).

Before You 
Begin...

Supplied with the training files for this and other case studies in this 
manual are simplified versions of the Part and Assembly Design 
Library directories. The purpose of this is to avoid conflict between 
your Design Library, installed with the SolidWorks software, and the 
Design Library-based parts that exist already in these training 
assemblies.

File Locations Before starting these lessons, you should open the Tools, Options 
dialog, and on the File Locations tab, browse to and add these training 
paths to the Design Library.

C:\SolidWorks 2005 Training 
Files\Routing\training design library

Routing Next, on the Routing tab, under Library folder, set to

C:\SolidWorks 2005 Training 
Files\Routing\training design library\routing

Also, click Automatic route on drop of clips.
Note This is the default install location for the SolidWorks training files. If 

the files were installed in an alternate location, this path should be set 
accordingly.

These locations should be used for all component insertions in this 
manual. It is important to set this path first to avoid conflict with the 
files in the other (SolidWorks installed) Design Library location.

Note Some of the paths displayed in illustrations of dialogs in the manual 
may not coincide with this guideline.
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1 Open assembly.
Open the assembly Tubing 
Assembly in the Tube Route 
directory. The assembly includes 
two tubing fittings, 
solidworks-lok male 
connector<1> and <2>. Each 
fitting contains the routing points 
CPoint2 and RPoint1.

2 Route Points.
Show the routing points using 
View, Routing Points.

Route 
Properties

The Route Properties are settings that define the characteristics of a 
route. It is used to determine which tube part is used on the route 3D 
Sketch, whether a flexible or orthogonal route is used and whether 
bends or elbows are used at changes in direction. 

The dialog is triggered when a new route is created.
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3 Start Route.
Zoom in on the 
manifold part.

Right-click the CPoint 
and select Start Route.

The Start Route dialog 
requests an Assembly 
file name. This name is 
used for the routing 
sub-assembly.

Leave the default name 
and click OK.

4 Route Properties Dialog.
Click OK and the Route Properties dialog appears.

Under Options, choose training design 
library\routing\tubing as the Library 
folder path. This sets the proper folder for the 
fittings chosen to represent the tube.

For Tube, choose tube-ss_t in 
the Tubes directory and Base 
configuration Tube .500in OD 
X .010in wall.

Clear Use flexible.

For Bends - Elbows, choose Bend 
radius: 1”and Center line 
position.

Click OK to start the route.

Note The Base configurations are restricted to those that match the 
nominal diameter set by the Connection Point.



Lesson 7 SolidWorks 2005 Training Manual
Tubing Routes

58 3D Sketch Route

5 Drag Route Line.
A short route line is started at the CPoint location. 
Select the endpoint of the line and drag it, 
increasing the length of the line. This is the start 
of the route.

6 Add.
Right-click the CPoint on the opposite side of the 
assembly and select Add to route. This adds 
another small route line as part of the current 
route.

3D Sketch 
Route

Routes can also be created from a manual 3D Sketch. The sketch is 
created in the Edit Route mode that occurs after Route Properties are 
completed.

7 Orthogonal route.
Complete the route by sketching an 
orthogonal line from the initial 
segment toward the end segment. 
Tab once to use the YZ plane.Drag 
Along Z, but don’t release the 
endpoint yet.
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8 Snap.
As with 2D sketching, lines will snap to 
horizontal and vertical positions. However these 
two segments are not on the same Y plane, so a 
horizontal sketch will not close the loop.

Drag the endpoint up to create an angled tube 
segment. The cursor shows we are still on the 
YZ plane.

9 Finish the sketch.
Drop the endpoint on the open endpoint of the 
other segment. The bend is added automatically.

Note This sketch could also be completed with a conventional X-Y-Z route, 
with 3 bends, using Merge to join open ends.

10 Close sketch and save.
Close the sketch. You are prompted to save the tubing part created. 
Click Save. Return to editing the top level assembly.

Deleting a Route Routes are sub-assemblies that can be edited or deleted as components. 
Deleting a route deletes all the components within it including tubes, 
3D Sketches and fittings.

11 Delete the route.
Select the component RouteAssy1-Tubing Assembly and press 
the Delete key. Click Yes to confirm deletion.

Spline Sketch Routes for flexible tubing can be created using a spline. The 3D sketch 
is created in Edit Route mode, but uses the spline tool instead of the 
line tool. 3D space is respected as the tool will form the spline as 
necessary through changes in X, Y and Z.
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12 Start a new route.
From the same CPoint, start a 
new route, with all the same 
parameters, except this time 
check Use flexible in the 
Route Properties dialog. 
This will allow for the use of a 
spline curve.

Add another route segment to 
the .375 AIR CONTROL 
VALVE as before.

13 Close off with a spline.

Select the spline  tool. Click and 
drag from one endpoint to the other.

Note It is not necessary to use Tab to change planes when dragging directly 
to an existing endpoint. The system will intuitively align itself in 3D 
space.

When released, the ends of the 
spline form tangent relations with 
the straight segments automatically.

Auto Routing Tubing routes, both flexible and orthogonal (or orthographic), can be 
automatically generated using the Auto Route option.

14 Delete spline.
Delete the existing spline segment. Leave the start and end sketch line 
segments.
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15 Auto Route Settings.
Right-click one of the open 
endpoints and choose 
Auto Route. Select the 
endpoint of the other 
segment. A spline is added 
connecting the endpoints. 
It is tangent to both line 
segments. Click OK.

16 Shape Spline.
Drag the line endpoints to shape 
the spline.

The spline shape can be further 
edited with the addition of spline 
points (right-click Insert Spline 
Point).

Tip For clearest manipulation of the added spline points, switch to side, 
front or top views of the design. 

Clips Auto routing can also be achieved by the drop of a clip from the Design 
Library. The clip must have appropriate RPoints and a mate reference.

17 Delete spline.
While still editing the sketch, delete the 
spline segment just created. Leave the two 
straight segments intact.

18 Drag and drop a clip.
From the Training Design Library, in the 
routing\tubing directory, drag the 
tubing-clip 0.5 into the assembly. 
Drop it on one of the small holes in the 
horizontal member above the tube.

Note Routing by dropping clips works with flexible tubing, not rigid,or with 
electrical wiring only (Use flexible checked in route properties).
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19 Result.
The tube is routed automatically through the 
clip. Two segments are added; a spline and a 
straight segment defined by the clip.

20 Repeat.
Add a second clip on the other hole. 
Again, the route is extended 
automatically.

Exit Insert Component mode.

21 Close the route.
Finish the route by 
using Auto Route 
between open 
endpoints.

If the minimum 
radius of curvature 
is exceeded, it can 
be adjusted 
afterwards by 
dragging the 
straight segments.

Note Clips and other route components can be selected manually to establish 
a sequence. Click View, Axes and select the axis within the routing 
component.
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22 Save tube.
Exit the sketch. The tube part used in the route is saved with the route 
from the Part Design Library. The default name is generated from the 
name of the configuration used and the parent assemblies.

Click Save.
23 Completed Tubing Route.

The tube is Tube-500X.010-RouteAssy0-Tubing Assembly 
with the configuration Tube .500in OD X .010in Wall. The 
length of the tube is listed following the configuration.

The Route1 component includes the route sketch, 3DSketch1.

Both the tube and the route are created in-context as indicated by the -> 
suffix.

24 Delete route.
Select the component RouteAssy0-Tubing Assembly and press 
the Delete key. Click Yes.
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Orthogonal 
Auto Route

Routes can also be created using Auto Route in an orthogonal scenario, 
rather than flexible. The sketch is created in the Edit Route mode that 
occurs after Route Properties are completed and uses right-angle bends 
only.

25 New route.
Start a new route from 
a CPoint using the 
same procedure as 
before. Type the 
custom assembly name 
Tubing Route 3D 
and click OK.

26 Route Properties.
Use the same settings in Route Properties but clear 
Use flexible and set Bend radius to 0.5”.

Click OK.

27 Auto Route.
Drag the open endpoints 
to about twice the 
length of the fitting.

Next select Auto Route 
and the Orthogonal 
route option. Use the 
up arrow in Alternate 
paths to move through 
each possible solution. 
Use the solution 
displayed at right.
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Note Some solutions can create invalid routes. When this happens, a warning 
dialog appears. 

For example, when there is not enough space between two 
perpendicular segments to put in a full radius of the default size, the 
segments will show as a sharp corner.  An adjustment to that particular 
radius or to the separation will be needed to show a proper radius. 

Simply click OK to continue.
28 Fully define.

Add the 5in 
dimension as 
shown to fully 
define the sketch. 
Exit the sketch 
and save the files.

Create Bend 
Tables

Bend Tables can be used to extract detailed information from a tubing 
route for fabrication. The information is available in several file 
formats including text, html and eDrawings™ eprt file.
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29 Create Bend Data.
Right-click Tubing Route 3D 
and select Create Bend Tables. 

For Options, click those shown at 
right and click Create.

The files created are listed in the 
Files group box.

Note You must have eDrawings™ installed to view the *.eprt file. The 
files are placed in a folder named Tubing Assembly under the 
current folder.
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30 View file.
Select the Tube-
500X.010-Tubing 
Route 3D-
Default.html file and 
click View Selected File(s) 

. 

Other options with the files include Copy All Files , Send Email 

Containing All Files  and Create a Zip Archive Containing All 

Files .
31 Bill of Materials.

Create a drawing of the Tubing Route 3D sub-assembly with one 
isometric view.

Select the view, and insert the BOM (Insert, Tables, Excel Based Bill 
of Materials...) using the Piping BOM Template (located in 
<SolidWorks install directory>\lang\english folder). It includes 
the CUT LENGTH property. 

32 Alternate BOM.
Alternatively, you can insert a standard (non-Excel) Bill of Materials 
and customize the cells or use the supplied
Tubing BOM Template.sldbomtbt template with Insert, 
Tables, Bill of Materials.

The template is located in the training design library folder.
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Editing a Route Tubing and piping routes can be edited to change: route diameters, add 
fittings, remove tube/pipe sections and create pipe penetrations. Most 
of these operations are performed while in Edit Route mode.

1 Open Tubing Options.
Open the assembly Tubing 
Options in the directory of the 
same name. It contains a flange 
and tube route.

Change Route 
Diameter

Change Route Diameter is used to change the diameter of the entire 
route including the tube and related fittings. In this example, the current 
nominal diameter of the tubing is 1 inch. This option is available in 
Edit route mode.

Where to Find It Right-click a line of the route and select Change Route Diameter.

2 Edit route.
Edit the existing route.

3 Larger Diameter.
Right-click the route and select 
Change Route Diameter. 
Select the configuration Tube 
Flange 1_25-150 from the 
dialog and click OK.

Note Using the Automatic selection of pipes and elbows check box 
would prevent the second dialog from appearing.

In the next dialog, select the 
same configuration name.

Note If the Route Properties dialog appears. select the file tube_ss_t for 
the pipe.
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4 Rebuild. 
Both the flange and tubing have 
been changed to match 1.25” 
diameter tubing. The name of the 
tubing part does not change with 
the diameter change.

Add Fitting Fittings such as flanges and tees can be added directly to the route 
without using the Design Library. This option is available in Edit 
Route mode.

Where to Find It Right-click a line of the route and select Add Fitting.

5 Edit the route.
Edit the route, then right-click 
the open endpoint of the 
sketch and select Add Fitting. 
Browse to the Training 
Design Library directory 
and select the 
slip_on_tube_flange-
ss_t component. from the 
Tubing folder.

Note It is important that you use the part from this directory because this is 
the same part that already exists in the assembly (a second instance).

Select the configuration Tube_Flange 
1_25-150 and click OK.
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Constrain Sketch 
to Fitting

Fittings that are added to an existing route endpoint are controlled by 
the sketch, moving with changes to the attachment point. Constrain 
Sketch to Fitting can be used to reverse that by repositioning the 
fitting and driving the sketch. This option is available in Edit Sub-
assembly mode and is usually used with piping.

Where to Find It Right-click a pipe of the route and select Constrain Sketch to 
Fitting or Constrain Fitting to Sketch.

6 Drag endpoint.
Edit the route sketch and 
drag the line indicated to 
reshape the route. The 
component is attached to the 
line and moves with it.

7 Drag fitting.
Exit the 3D Sketch, remaining 
in Edit Sub-assembly mode. 
Right-click the 
slip_on_tube_flange-
ss_t<2> component and 
select Constrain Sketch to 
Fitting. Drag the fitting 
component and drop it. The 
route will re-connect to it.

Select Constrain Fitting to 
Sketch to return to control by 
the sketch.

8 Save and close.
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Upon successful completion of this lesson, you will be able to:

Route fabricated piping using orthogonal 3D sketching and angled 
3D sketching.

Use an alternate elbow in a piping route.

Use orthogonal auto routing with pipes.

Edit a piping route and add fittings to a route.
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Setup for Piping As before, be sure Tools, Options, 
System Options, Routing, Library 
folder path is set to the training design 
library directory:

training design library\
routing\piping

Sketching a 
Route

This route will be sketched in a similar manner to the 3D Sketch of the 
previous lesson.

1 Open assembly.
Open the assembly Piping 
Assembly.

2 Set Editing Colors.
Click Tools, Options, System 
Options and Color. Clear the 
option Use specified colors when 
editing parts in assemblies.
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3 Routing components.
The components .375 AIR 
CONTROL VALVE and three 
instances of the manifold are 
routing components. Click View, 
Routing Points to see the 
connection and routing points of 
each one.

Starting the Route Piping routes are started in the same way as tubing routes.
4 Start route at CPoint.

Start the route at a the connection point 
CPoint2 of manifold<1>. Right-click 
the CPoint and select Start Route.

5 Start Route Settings.
In the Start Route 
dialog, use the default 
name of the route sub-
assembly and use the 
default template.

6 Route Properties.
Click OK and the Route Properties dialog appears.

Under Options, choose training design 
library\routing\piping\Threaded 
Fittings (NPT)as the Library folder path. This 
sets the proper folder for the fittings chosen to 
represent the pipe and bends.
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For Pipe, choose 
Threaded_Steel_Pipe_t and 
Base configuration Threaded 
Pipe 0.375 in, Sch 40.

For Bends - Elbows, choose 
Threaded_Elbow--90deg_t 
and Base configuration CLASS 
2000 THREADED ELBOW, 
.375IN.

Note that the base configurations are 
restricted to those that match the 
nominal diameter set by the 
Connection Point.

Click OK.

Note After adjusting the Library folder path, it is a good idea to reload the 
part files (tube, pipe and elbow) via the Browse... buttons to insure that 
the correct source file is displayed and loaded.

Note The Parameters option can be used to limit 
selections to a certain Specification such as a 
schedule or thickness value.

7 Route is started.
The route line is started as a short line in the 
direction indicated by the connection point. 
Drag the endpoint to make the line longer. 
This is the start of the route.
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8 Add to route.
Right-click the CPoint4 on .375 AIR 
CONTROL VALVE<1> and select Add to 
route. Drag the endpoint away from the 
Frame. This is the end of the route.

Piping Auto 
Route

Piping routes require lines and arcs in 3D space. In order to create 
these, a 3D Sketch is required. In this example, the sketch will be 
created automatically using and Auto Route.

9 Auto Route.
Select the open 
endpoints and use an 
Orthogonal route. 
Select the solution that 
looks like the one 
shown at right.

Add the 8in dimension 
to the starting line.

10 Exit the sketch.
Close the sketch and Save the pipe part with the default name.

Elbow Selection Piping routes require elbows at the common endpoints (bends) of lines. 
To complete the route, identify the proper elbow to use in the Bends - 
Elbows dialog. 
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11 Elbows.
Select elbows for the route. 
In this example, all elbows 
use the 
threaded_elbow--
90deg_t part with the 
CLASS 2000 THREADED 
ELBOW, .375 in 
configuration.

12 Completed route.
The route includes four pipe 
spools and three 90 degree 
elbows.

The pipe component instances include the individual pipe lengths, 
listed after the configuration name.
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13 Pipe Lengths.
Changing the transparency of 
the elbows shows where the 
pipe segments end. The pipe is 
stopped at the CPoint locations 
in the fittings.

Hide the sub-assembly 
RouteAssy0-Piping 
Assembly for clarity in the 
next section.

Angled 3D 
Sketch Route

Routes that include angles other than 90° between lines induce some 
selection options when the route is completed. An example of this 
might be a drain pipe that requires a pitch other than horizontal.

In order to satisfy the route, you have options to:
Use Default/Alternate Elbow
Select an alternative to the default elbow selected in the Route 
Properties. If the library contains an elbow of the proper angle 
(commonly a 45) it can be selected and used.
Make Custom Elbow
Create a custom elbow from a selected elbow such as the default 
90° elbow (except threaded). The selected elbow is copied and 
modified to the angle formed. The component name is suffixed 
with _Local# and the configuration name includes the diameter, 
angle and radius of the elbow.

Note Creation of a custom elbow from a standard threaded elbow, though 
possible within SolidWorks, is not practical or realistic.

Create Form Bends
Form bends can be used where the piping is bent like tubing rather 
than connected with elbows.

1 Set Editing Colors.
Click Tools, Options, System Options and Color. Check the option 
Use specified colors when editing parts in assemblies. 
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This option changes the colors of component being edited to 
Assembly, Edit Part color. All other components are set to the 
Assembly, Non-Edit Parts color (default grey).

2 New Route.
Add a new route, using the 
default route name, starting at 
the connection point on the 
lower portion of the 
manifold<1> component. 
Drag the new route line down 
below the Frame. 

3 Add to the route.
Right-click the CPoint on the 
manifold<2> and select 
Add to route. This starts 
another route line in the 
current route. Drag the line.

4 Using the Space Handles.
Continue the route by clicking 
the Line tool and starting a 
new line. Click the initial open endpoint and drag the other end of the 
line.

Press the Tab key to orient the Space Handles. When the axis 
orientation shown appears, stop clicking the Tab key and drag the line 
along the axis labelled (plane YZ). Locate the end of the line 
roughly as shown.
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5 Sketch in plane.
Start the next line segment and press Tab to sketch an angled line in the 
ZX plane. Watch for light colored guides along the axes Z and X of the 
plane. 

Tip Due to the nature of a 2D graphical representation of 3D space, 
dragging 3D sketch entities after creation can give undesirable results, 
and is not recommended without first applying some constraints to the 
sketch.

6 Sketch along X Axis.
Create the last line along the horizontal  axis (plane ZX) as shown.
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7 Merge Endpoints.
Select the open endpoints and add a Merge relation.

8 Perpendicular relation.
In order to keep the angled in the same plane as the adjacent lines, add 
a Perpendicular between the angled line and initial line.
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9 Dimensions.
Add the angle and linear dimensions as shown. The angle dimension 
forces both corners to be 45° angles.

Alternate Elbows All corners that are not equal to 90°, (equal to the default elbow), are 
flagged by the route as requiring a different type of elbow. The proper 
elbow must be selected for each bend.

10 Exit the route.
Exit the route using Exit Sketch to access the Bends - Elbow dialog.

11 Choose Elbow.
Exit the sketch and 
the Bends - 
Elbows dialog 
appears. The first 
elbow in question 
is zoomed and 
highlighted.

The Bends - 
Elbows dialog 
appears.
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Use Browse to select the 
threaded_elbow--
45deg_t component for use 
at this corner. Select the 
CLASS 2000 THREADED 
ELBOW, .750IN as the 
configuration to use and click 
OK.

Select the same replacement 
elbow for the next 45° corner using the 
same method.

Next save the pipe part file.

12 Completed route.
Edit the main assembly, closing the route sub-assembly. The pipes and 
associated elbows, both 90° and 45°, are added to the route 
RouteAssy1-Piping Assembly.

Editing a Route Once created, the route and associated sub-assembly can be edited to 
change route sketch, add fittings or delete them.
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13 Split Entities.
Edit the route. Use Split Entities to break the line as shown. Add a 
dimension to locate the break. 

Adding Fittings Pipe and elbow components are 
added to the route automatically 
based on the shape of the route’s 3D 
Sketch. Other components like tees 
and eccentric reducers must be 
added manually at specific locations 
along the pipe route.

Fitting Orientation The fitting orientation can be flipped using the Tab key provided an 
orientation line is not used. The orientation line is sketched from the 
end of the split line. An angled orientation line can be created using 
references planes and axes.
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14 Orientation Line.
Add a line along the  axis in the 
direction of the branch line as shown. 
This will specify the orientation of the 
tee for drag-drop from the Design 
Library.

15 Add threaded_tee_t.
Drag and drop the fitting 
threaded_tee_t on the 
connection point, selecting the 
configuration as shown.

16 Add to route.
Add to the route 
from CPoint2 of 
the tee and from 
CPoint1 of 
manifold<3>.

Tip Do not use Add to route from the tee side of the line because it is 
already an active route line.
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17 Auto route.
Use Auto route to 
complete the route. 
Choose the solution 
similar to the one 
shown at right.

18 Dimension.
Add a dimension 
(6in) to fully 
define the sketch.

Using Assembly 
Fittings

Assembly based fittings include any fittings (valves and strainers for 
example) the are represented as multiple part components. They are 
added to the route using the same methods as part fittings.
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19 Add Fitting.
Use Split Entities to break the angled line and add 
a 3in dimension to the end line.

Right-click the point and select Add Fitting and 
select the assembly Valve_t (located in the 
training design library\routing\
assembly fittings\valves folder) and list 
all configurations to select the 0.75in 
configuration.

Tip The fitting can also be dragged and dropped from the Design Library 
similar to the tee fitting.

20 Completed Route.
Exiting the sketch again calls the Bends - Elbows dialog to select 
another 45° elbow.
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Remove Tube/Pipe The Remove Tube/Pipe option is used to create a condition where 
bends or fittings contact each other directly. This option is available in 
Edit Route mode and is usually used with piping.

Where to Find It Right-click a pipe of the route and select Remove Pipe or Remove 
Tube.

21 Open Piping Options.
Open the assembly Piping Options and edit the route.

22 Select Line.
Select the line to be 
removed, indicated at 
right, and right-click 
Remove Pipe.

The line, and associated 
pipe, has been removed 
from the route.

Custom Pipe/Tube 
Configurations

Custom Pipe/Tube Configurations can be created where pipe or tube 
lengths are equal but differ in geometry. This is useful when a 
penetration is used on one of two equal length pipes. This option is 
available in Edit Sub-assembly mode and is usually used with piping.

Where to Find It Right-click a pipe of the route and select Create Custom Pipe/Tube 
Configurations.
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23 Change 
Lengths.
Change the 
length of the last 
pipe in the route 
to match the first 
at 15in.

24 Configuration.
Exit the sketch. Right-
click the 1in 
Schedule40<1> 
and choose Create 
Custom Pipe/Tube 
Configuration. 

Pipe Penetrations Pipe Penetrations can be created between intersection pipes. Both 
pipes are cut by the process. This option is available in Edit Route 
mode and is usually used with piping.

Where to Find It Right-click an endpoint of the connecting route and select Penetrate.

25 Add Line.
Edit the route sketch and 
add a line to the 3D Sketch 
as shown at right (blue). Use 
a Coincident relation 
between the endpoint and 
the route line.

Do not break the route line.
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26 Flange.
Add a Slip_On_Weld_
Flange_t, diameter 
0.75, to the open 
endpoint. The pipe is added 
along the line.

Note Use the pipe pipe_t and the elbow LR_Inch_Elbow_t.

The pipes conflict.

27 Penetrate.
Right-click the junction 
point and select 
Penetrate.

Save the new pipe 
segment.



SolidWorks 2005 Training Manual

91

Lesson 9
Building Routing Library

Parts

Upon successful completion of this lesson, you will be able to:

Generate libraries of tubing and piping parts, including elbows and 
routing component assemblies, such as valves.
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Fabricated Tube 
or Pipe Parts

Fabricated Tube or Pipe Parts can be created for use in a route. They 
are used along the length of the 3d Sketch created while routing. The 
specific naming of dimensions, sketches and features is important to 
ensure that the finished component is recognized as a routing 
component.

Note Design of electrical routing parts is covered in Lesson 10: Electrical 
Routes.

In this example, a PVC pipe will be created. 

Note The actual length of the pipe will be determined by the straight sections 
of the route.

The values used in this example are 
dimensions for a 1/2” nominal diameter 
PVC pipe. Other sizes will be added 
through the design table.

Required naming information for the Tube/Pipe part: 

Note It is important to note that tubing and tubing components must use the 
term “pipe”, not “tube”, in these instances.

Base Feature 
Sketch

Name: PipeSketch Dimensions: 
InnerDiameter and 
OuterDiameter

Base Feature: Name: Extrusion Dimension: Length

Sketch: Name: FilterSketch Dimension: 
NominalDiameter

Configuration 
Specific 
Properties

Name: Pipe 
Identifier

Value: <pipe description>
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1 New Part.
Open a new inch part and edit the material to be Plastics, PVC Rigid.

2 Sketch.
Create a new sketch on Front 
Plane (or Plane1), naming 
it PipeSketch. Create 
concentric circles as shown and 
name the dimensions 
OuterDiameter and 
InnerDiameter as shown.

3 Extrusion.
Create a boss feature named 
Extrusion using a depth of 
1”. Name the depth dimension 
Length.

4 Nominal Diameter.
Add a new sketch on the front 
face, naming it 
FilterSketch. Add a 
construction circle and a 
dimension named 
NominalDiameter. 
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5 Configuration Specific Properties.
There are Configuration Specific Properties that may be assigned to 
the part through File, Properties. These properties will be transferred 
to the design table.

Add the following properties and values as shown below:

Note In order to be recognized as a pipe component, only the Pipe 
Identifier property is required, but all descriptions should be 
carried with the library part.

Again, it is important to note that even a Tube part needs the property 
called Pipe Identifier.
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6 Auto-create Design Table.
Using Insert, Design Table..., a design table will be 
automatically created in the part. 

Use the settings shown for the new design table.

7 Add Dimensions.
Add the 
selected 
Dimensions to 
the design table 
using Shift-
select and OK.

8 Close Design Table.
Click outside the design table to close it. The design table changes will 
be saved.
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9 Edit Table.
Right-click the design table icon and Edit Table. Add the selected 
Parameters selected to the table.

10 Add new configurations.
While editing the table, replace the name Default on the first 
configuration and add three new ones as shown. Copy and paste where 
appropriate.
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11 Configurations.
The configurations 
are added, successful 
ones being listed in 
the message box.

12 Remove Default.
The Default configuration is no longer 
needed and can be deleted from the 
ConfigurationManager.

13 Add to Design Library.
Add the part to the training design library folder by 
drag and drop. Another method is to add the folder where the 
file is located to the Design Library setting in Options, File 
Locations.

Tip When adding parts to the Palette, it is best to create a new folder for a 
set of similar components.

Elbow Parts Elbow Parts can be created for use in a route where the line changes 
direction. Generally, elbows are created for the conditions where pipes 
meet at right (90 degree) and 45 degree angles. Other angles are usually 
covered by using Custom Elbows, automatically converted from the 
standard ones.

Like pipes, the specific naming of dimensions, sketches and features is 
important to ensure that the finished component is recognized as a 
routing component. Note that tube routes do not use elbows.

In this example, a PVC elbow will be created.
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1 Elbow sketch.
Open a new part file with inch units.

Create a new sketch on Front 
Plane, naming it ElbowArc. Add 
construction lines and a centerpoint 
arc as shown. Fully define the sketch 
and name the dimensions 
BendAngle and BendRadius.

Set the angle to 90 degrees before 
closing the sketch.

2 Route sketch.
Add a new plane using Normal to 
curve at the end of the arc. Create a 
new sketch named Route for the 
cross section of the elbow. Add the 
Diameter and ID dimensions as 
shown.
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3 Sweep.
Sweep the Profile Route 
along the Path ElbowArc.

4 Hub.
Create a new feature named HubA 
that includes a concentric circle of 
diameter 1.197in that is extruded to a 
height (depth) of 0.247in.

5 Link Values.
Use Link Values to add 
names to the extrusion 
diameter and depth values 
as shown:

Diameter = HubOD

Depth = HubLength

Adding a link value 
changes the name of the 
dimension. These will be 
linked to the dimensions 
of the other flange.
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6 Cut hub.
Create a circle, and add the 
Link Value PipeOD to the 
diameter dimension.

Cut with Up To Surface, 
using the rear face of the 
HubA.

7 Copy and Paste.
Copy and paste the boss and cut 
created above, repairing any 
errors. The link values will be 
included with the geometry.

8 Points.
On the same plane that you created 
ElbowArc (Front Plane), create a 
new sketch named ConnectPoints. 
Show the ElbowArc sketch and add 
points as shown. 

The third point is added at the 
theoretical intersection of the lines 
meeting at the elbow.

Hide the ElbowArc sketch again.

Tip Add the points first, then connect them with vertical and horizontal 
construction lines to fully define the location of the third point.
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Routing Points Routing points, which include Connection Points (CPoints) and Route 
Points (RPoints), are used to determine several details of the route.

CPoints determine where the routing ends, the direction that it 
enters or exits the fitting, and the nominal diameter of the pipe, 
tube, or cable.
RPoints are used for placement of fittings on a route line sketch 
endpoint.

Tip CPoints and RPoints can be renamed to suit your design.

9 Add Connection Points.
Add a CPoint by selecting the 
face and sketch point.

Set Route type to Fabricated 
Pipe.

Set the Nominal diameter to 
0.5”.

Add another CPoint at the lower 
connection point. Double-
clicking the feature displays the 
nominal diameter at the 
connection point.

Click View, Routing Points to 
see the CPoint and Rpoint 
symbols.
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10 Route Point.
Add a Route Point at the 
third sketch point location. 

11 Configuration Specific Properties.
Add the property as shown.
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12 Material.
Edit the material to PVC rigid.

13 Design Table.
Create a Design Table and add data as shown.

14 Add the part to the Design Library.

Fitting Parts Fitting Parts are more generic and can be created for use in a route. 
They are anything that does not fit into the standard categories of pipe/
tube, elbow, flange or reducer. 

In this example, a PVC coupling will be created.



SolidWorks 2005 Training Manual Lesson 9
Building Routing Library Parts

Fitting Parts 105

1 New part and Sketch.
Create a new part file with units inches and sketch using centerlines for 
symmetry. Use the dimension names as shown.

2 Revolve and Mirror.
Create a revolved feature, creating 
the upper half of the part. use 
Mirror to complete the part.
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3 Route Points.
Create points in a 
sketch and add 
CPoints and an 
RPoint as shown. 

Set type to 
Fabricated Pipe.

Set the Nominal 
diameter to 0.5 
for each 
connection point.

Note If this were a tubing connector, the CPoints would be designated as 
type Tubing. For electrical, the designation would be Electrical.

4 Add properties.
Add the configuration specific properties shown below.
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5 Populate the Design Table.

Note You may see other parameters entered into the table by default. These 
can be added, removed or customized:

D1@Revolve1
This is the revolve angle of the base feature (360 degrees) and does 
not need to be configured.

MinStraightLength@CPoint1
This is the minimum length of pipe/tube used to start a route, in 
order to avoid excessive strain (default varies with configuration 
and size).

EndLengthAdjustment@CPoint1
This is an additional length that can be added to the pipe/tube to 
allow for end treatments such as swaging (default is zero).

Flange Parts Flange Parts are used at the start or end of the route and are generally 
used for connections to equipment. Flange parts contain only one 
routing point, a CPoint.

In this example, a PVC flange will be created from an existing part.

1 Open Flange.sldprt.
Open the existing part Flange.
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2 Connection Point.
Add a point and Fabricated 
Pipe CPoint inside the bore, 
diameter 0.5in.

For a tubing flange, you would 
add a Tubing type CPoint.

3 Set properties.
Add the configuration specific 
property SWbompartno 
Flange, 0.5in, Sch 
40, PVC to the default 
configuration.

4 Design Table.
Insert a design table, as shown below.

5 Mate Reference.
Add a Mate 
Reference on the 
rear edge of the part 
as shown.

6 Save.
Save as PVC 
Flange and add it to 
the Design Library.
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Assembly 
Fittings

Routing “part” fittings that are actually assemblies can be created for 
use through the Assembly Palette. These assemblies must contain 
routing points at the assembly level based on routing points in the 
component parts.

1 Open valve assembly.
Open the PVC Ball Valve 
assembly. It consists of three 
components: 
PVC Valve Body,
PVC Valve Stem, and
PVC Valve Handle.

2 Routing Parts.
One part in the assembly is a 
routing part. The PVC Valve 
Body contains the required 
Routing Points: Fabricated pipe 
CPoints and RPoint.

The remaining parts are 
components in the assembly but 
contain no routing information.

Note Two parts in the assembly contain multiple configurations: the PVC 
Valve Body and PVC Valve Stem. These component contain 
compatible configurations for both a 0.75” route and a 0.50” route.

Assembly-Level 
Routing Points

Using the routing points embedded in the component parts, you can add 
assembly-level routing points. ACPoints are used to locate the ends of 
the route line, in this example where the pipe part is cut by the 
assembly component. ARPoints are used to locate the assembly on the 
route sketch.

3 View points.
Click View, Routing Points to see the 
embedded CPoints and RPoint.
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4 Assembly Connection 
Point.
Click the Connection 
Point icon and, on the 
model, select CPoint1 
of PVC Valve Body<1> 
and click OK.

The feature ACPoint1 is 
added to the assembly 
using the settings taken 
from CPoint1.

Repeat the procedure for the other CPoint of the PVC Valve Body, 
this time selecting the CPoint from the FeatureManager.

5 Assembly Route Point.
Add an assembly-based route point 
using the route point of the Valve 
Body component. It appears as the 
feature ARPoint1.

6 Configurations.
If the assembly is being used for 
multiple route diameters, multiple 
configurations must be used. The 
proper part configurations for each 
assembly configuration should be selected through a design table.
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7 Add to Design Library.
Drag and drop the top level assembly icon into the Design 
Library.

Note Saving an assembly this way does not save the reference parts in the 
same location. To be safe, the part files should be copied to the Palette 
Assembly folder using File, Find References..., or Windows Explorer. 
In this way, should the original part files be moved or deleted, the 
assembly will find the parts in the local folder.

If not saved onto the Palette, the assembly can still be added easily to a 
route assembly using Add Fitting.
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Exercise 1:
Auto routing 
with Tubes

Create multiple route 
assembles using tub-
ing library parts.

This lab uses the 
following skills:

Setting route 
options and route 
properties.
Auto routing.

Units: inches

Setup Setup SolidWorks Routing to use a different library, in this example the 
included tubing library.

1 Routing options.
Click Tools, Options, System Options, Routing and set the Library 
folder to training design library\routing\tubing.

2 Design library settings.
Click Tools, Options, System Options, File Locations and add the 
training design library folder.

Creating the 
Routes

The route is added to an existing assembly that contains some 
components to start and stop it.

3 Open Tubing Lab.
Open the existing assembly 
Tubing Lab. It contains 
sketches and 6 
solidworks-
lok_male_connector_t 
fittings.

4 Routing Points.
Click View, Routing Points to 
display the routing points.

5 Initial tube route.
Create Tube Route A using a 0.5in tube-ss_t tube with radius 
0.5in.
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Use an Orthogonal Auto route to create the route. 
Choose a solution similar to the one shown at right.

Add a dimension to fully 
define the sketch.

6 Second tube 
route.
Add a second 
route, Tube 
Route B, to 
the assembly. 
Use the same 
settings and 
dimension 
from the first 
route.
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7 Final tube route.
Add a third route, 
Tube Route C, to 
the assembly. Use 
the same settings 
and dimension 
from the second 
route.

8 Save and close.
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Exercise 2:
Multiple Piping 
Routes

Add to this assembly to create 
multiple piping routes and asso-
ciated pipe fittings.

This lab uses the following 
skills:

Auto routing for piping.
Creating multiple piping 
routes.
Add branch lines and tee 
fittings.
Add inline fittings like 
valves and unions.
Create piping drawings.

Units: inches

Procedure Open an existing assembly.
1 Settings.

Under Tools, Options, System Options, Routing use the Library 
folder \\training design library\routing\piping.

2 Open Multiple Routes.
Open the Multiple Routes assembly. It contains tank components 
placed to start and end piping routes.

Adding the first 
route

Add the first piping route.

3 Add Flange.
Drag and drop a 
welding neck 
flange fitting onto the 
flange of Feeder Tank 
<1>. Use the 
configuration WNeck 
Flange 150-NPS2 for 
the 2” version.

4 Route name.
Name the route
Route# 1 and use the 
default route assembly 
template.
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5 Route properties.
Use the following settings for the route properties. The source 
library files are in
piping/threaded fittings (npt).
Pipe

Select threaded steel pipe with the 2in Sch 40 configuration.
Elbow
Click Always use elbow and select threaded elbow--90deg 
with the CLASS 2000 THREADED ELBOW, 2.00 IN configuration.

6 Pipe name.
Exit the route sketch using right-click Exit Sketch. When saving the 
pipe configuration, use the default naming convention 2in 
Schedule40-Route# 1.

Ending Route Line Creating multiple route lines in the same route assembly can be used to 
represent the start and end of a route. Having the start and end lines 
makes it possible to use the Auto Route function.

7 Add fitting to existing route.
Drag and drop another welding 
neck flange onto the flange of 
the Holding Tank<1> 
component. At the Start Route 
dialog, click Cancel. Click OK to insert the component into the 
assembly.

8 Edit Route.
Right-click on the Route# 1 sub-assembly or the 
Route1 feature in the active sub-assembly and 
choose Edit Route. This action puts edits the 3D 
Sketch of the route feature.
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9 Add to route.
Right-click CPoint of the 
new flange and choose 
Add To Route. A route 
line is added from the 
Cpoint.

Using Auto Route The Auto Route function can be used to connect open route endpoints 
with a series of automatically generated route lines and fillets. 
Generally several solutions are offered.

Tip Pipe routes are limited to Orthogonal routes only.
10 Auto Route.

Select either of the open endpoints and right-click Auto Route. Select 
the other endpoint to see a solution route.

11 Select solution.
Go to the simplest solution (least elbows and 
pipe spools) and click OK to use it. Save the 
pipe using the default naming as 
2in_Schedule40_Route# 1. 

12 Exit the sub-assembly.
Click Edit Component 

 to complete editing 
of the sub-assembly. Use 
CLASS 2000 elbows.
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13 Add Route #2.
Using the same 
procedure, create 
Route #2 with the 
same settings. Use 
Auto Route to 
connect the open 
endpoints in this 
solution.

14 Add fitting.
Right-click Exit 
Sketch and add 
another welding 
neck flange to the 
route. Again, cancel 
the new route and 
place the fitting in the 
assembly. 

15 Add to route.
Use Add to route to 
create a line from the 
new flange. Use 
Split Entities to 
break the line above 
it.
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16 Add tee.
Add a threaded 
tee (CLASS 2000) 
to the junction 
between the lines.

Adding Assembly 
Fittings

Add an assembly fitting (valve) to the route.

17 Add valve.
Use Split Entities to break the 
new riser near the midpoint. Drag 
the 2incontrolvalve from 
the assembly fittings/
valves folder and drop it.

18 Editing the 
sketch.
Follow the 
same 
procedure 
to create 
Route #3. 
Use the
auto route 
solution that 
includes a 
45° angle as 
shown. 
Fully define 
and exit the 
sketch.

45°
Elbow
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19 Elbows.
The default elbow setting is 
for 90° elbows. If a 45° elbow 
is needed, it must be selected 
explicitly in the Bends - 
Elbows dialog with the 
Browse button.

Select the threaded 
elbow--45deg fitting.

20 Route #4.
Add the fourth route, 
adding the 8” and 80” 
dimensions to fully define 
the sketch. 

21 Add unions.
Edit routes and add 
threaded union fittings to 
Route# 3 and Route# 4 as 
shown.

Piping Drawings Create piping drawings.
22 Sub-assembly Drawing.

Create a drawing of the sub-assembly Route# 2 using the A-
Scale1to2 template.

Tip Use the bom-standard template for the BOM. Use Column 
Properties to change the DESCRIPTION column to one that uses the 
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custom property swpipelength.

23 Save and close the files.
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Exercise 3:
Creating Library 
Parts

Edit this part and create a library 
part for use in another lab.

This lab uses the following skills:

Adding reference geometry.
Creating CPoints and RPoints.
Adding parts to the Design 
Library.

Units: inches

Note This Exercise illustrates the routing of electrical conduit as piping. 
Currently it is not possible to route electrically through conduit.

Function The library part is an 
electrical box that is 
placed inline on the route. 
It is placed at a common 
endpoint on the route line 
and cuts the pipe back in 
two places.

The lower image shows 
the section view of the 
part and pipe line.



SolidWorks 2005 Training Manual

124 Exercise 3

Procedure Open an existing part.

1 Open PVC Inline Box.
Open the PVC Inline Box part. It is an imported solid model.

2 Add point.
Sketch on the inner face as 
shown. Add a point that is 
Concentric to the circular 
edges.

3 Repeat.
Repeat the procedure on 
the opposite side creating 
another concentric point.
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4 Plane.
Create a new 
reference plane 
using the selected 
face and either of 
the points. Start a 
new sketch on this 
plane.

5 Point between.
Add a point at the 
origin as shown. 
Hide the plane.
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6 Cpoints and Rpoint.
Create CPoints using the points and faces used to create the points. Use 
the settings for Fabricated Pipe and Nominal Diameter 0.5”. Create 
one Rpoint using the point between the CPoints.

7 Design table.
Auto-create a design table for 
the part. Add the configuration 
name Inline Box, 
0.5in, Sch 40, PVC as a 
copy of Default.

8 Add to library.
Drag and drop the part into the PVC folder. Keep the 
name PVC Inline Box. 
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Exercise 4:
Using Library 
Parts

Create a route assembly using a set of PVC 
library parts, including one created in the pre-
vious lab, Exercise 3: Creating Library Parts 
on page 123.

This lab uses the following skills:

Setting route options and route properties.
3D sketching.
Adding library parts to the route.

Units: inches

Setup Setup SolidWorks Routing to use a different library, in this example the 
included PVC library. These settings point the software to the library 
fittings that you are currently using.

1 Routing options.
Click Tools, Options, System Options, 
Routing and set the Library folder to 
PVC.

2 Design library settings.
Click Tools, Options, System 
Options, File Locations and add 
the PVC folder.

Starting the Route The route is added to an existing assembly that contains some 
components to start and stop it.

3 Open PVC Assembly.
Open the existing assembly PVC Assembly. 
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4 Insert fitting.
Drag the PVC Wall Mount fitting 
and drop it on the edge of the 
circular hole in the Mount<1> 
fitting. The fitting contains a mate 
reference and will snap to the hole.

5 Start Route.
The fitting also 
contains routing 
features to begin a new 
route. Name the 
assembly Route1-
PVC Assembly and 
make sure that the routeAssembly template is used.

Route Properties The route properties determine the characteristics of the route including 
the pipe diameter, elbow selection and library source.

6 Pipe.
The Pipe setting determines what part is used to 
represent the straight pipe spools. Set it to PVC 
Pipe and the 0.5in base configuration.

7 Bends - Elbows.
The Bends - Elbows setting determines what 
should be done where lines change direction. Click 
Always use elbow, the PVC Elbow and the 
0.5in base configuration

8 Options.
The Options setting sets the library folder for 
fittings and automatic creation options. Select the 
PVC library folder and click all three options.
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3D Sketching Use 3D sketching to create the route.
9 Lines.

From the starting line, add the lines shown 
at right in the 3D sketch. 

10 Relation and dimensions.
Add a coincident relation between the riser and 
the OUT axis. Add dimensions from the top face 
of the Mount<2> fitting as shown.

Note The sketch remains underdefined.
11 Split Entities.

Use Split Entities to break the lines 
in three places as shown. Dimension 
the resulting endpoints as shown.

Adding fittings Add inline and terminal fittings to the route.

All pipes and route fittings (library part components) are 0.5in, 
Schedule 40 configurations.
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12 Add PVC Inline Box.
Drag the PVC Inline Box 
part into the assembly and 
drop it on the endpoint.

13 More inline fittings.
Add another instance of the 
PVC Inline Box. Also, 
drag and drop a PVC 
Coupling as shown.

Note If you did not complete the previous lab Exercise 3: Creating Library 
Parts on page 123, use PVC Inline Box_&.
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Lesson 10
Electrical Routes

Upon successful completion of this lesson, you will be able to:

Route wires and cables using Auto Route and hardware.

Add wire data to a route subassembly.
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Electrical 
Routes

Electrical Routes use electrical components and an optional cable /
wire library to form wire and harness route sub-assemblies. In their 
simplest form, electrical routes are much like flexible tubing routes. 
However, Electrical Harnessing and Cable Detailing adds the ability to 
specify individual pins, wire types and colors, wire coverings and other 
attributes. Harnessing will be covered in depth in Lesson 11: Importing 
Electrical Data and Electrical Harnessing.

Electrical routes also differ from tubing and piping routes in that there 
is no source SolidWorks part file for the wire, as there is for a tube or 
pipe.
Instead, electrical routes may use an optional cable / wire library file. 
The cable / wire library defines the attributes of wires and cables, and is 
in .xml format, but may be imported from Excel format. With no cable 
/ wire library specified, the route uses a generic wire or cable part 
representation.

Other elements of electrical routing:

Routing Hardware, which includes clips, clamps and brackets, as 
well as ring terminals and other simple connectors. These help to 
define the start and end points, the path of the route around other 
components, and are useful in auto routing.
A Component Library file cross-references the components in a 
from-to list (see below) to the SolidWorks part documents for those 
components. The component library file is also in .xml format 
(importable from Excel). Component libraries will be covered in 
more depth in Lesson 11: Importing Electrical Data and Electrical 
Harnessing. 
A From-To List defines component and pin connection data for a 
route. You can generate a From-To list manually, or use a third-
party schematic program that generates the electrical connection 
data. From-To lists are in Excel format. From-To lists will be 
covered in more depth in Lesson 11: Importing Electrical Data and 
Electrical Harnessing.
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Basic Electrical 
Routing

Basic electrical routing is very similar to tube routing. Wires can be 
routed manually or automatically, orthogonally or flexibly. Clips can 
aid in route placement.

1 Open assembly Signal control system.
The assembly includes an enclosure, a circuit board assembly, and 
some pre-placed wire clips.

Electrical 
Connection Points

There are some unique properties of Connection Points (CPoint) for 
electrical route connectors:

The Nominal diameter of an electrical CPoint defines the 
maximum diameter of cable or wire bundle that the connector can 
take.
The Conductor split length adds to the cut length of the cable to 
allow for strip back, termination, and so on.
2d Schematic pin id assigns identification information for the pin 
if the connection point is for one pin in a multi-pin connector. If the 
connection point is for multiple pins, leave blank.

2 The ring terminal.
In the Design Library, under routing\electrical, 
locate ring_term_18-22_awg-x_6. Right click on it, 
and select Open.

3 Edit CPoint.
Right-click the CPoint, and select Edit Feature.
As with other CPoints, it references a point sketch and a planar face.

4 Electrical Parameters.
The Nominal diameter sets the maximum allowable wire diameter for 
this connector at 0.70”
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The Conductor split length is set at 0.3937” (10 mm). A wire 
connected to this terminal will have this value added to its calculated 
length.

This is a single wire connector, so there is no reason for a Schematic 
pin id. For connectors with multiple contacts or pins, it may be 
desirable to add a CPoint for each and index them for individual wire 
assignments.
Exit CPoint properties and close this part file.

5 View Orientation.
Orient the assembly model to the view called Wire route 1.

6 Locate the 2 washers.
On the side panel closest 
to the circuit board, and 
on the edge of the circuit 
board itself, there are two 
washers mated to small 
holes. We will add a 
ground wire between 
these two contact points.

Drag one of these 
terminals onto the circuit 
board. When dragged 
over the washer, the pin-
in-hole cursor appears, indicating a concentric mate reference. Drop the 
terminal onto the washer. The Start Route dialog appears.

7 Create and save the route.
Accept the default route sub-assembly name to start the route.

washers
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Electrical Route 
Properties

The Properties dialog for an electrical route differs from that of other 
route types:
Sub-type

Harness: A route with a bundle of wires or cables.

Cable/Wire: A route with a single cable or wire.
OD
Set the route outside diameter. Can not exceed the Nominal Diameter 
assigned to the CPoint.
Fix diameter
Sets the route diameter to the value set in OD. Clear to enable diameter 
updates based on the diameters of the cables and wires that you route. 
Generally, this option should be left unchecked.

See SolidWorks Routing Help Topics in the Help menu for more 
information.

8 Properties.
In the Route Properties dialog, select sub-
type Cable/Wire, and set the OD to 1.5mm.

Make sure Fix diameter is unchecked.

While the Route Properties dialog is still 
displayed, the orientation of the ring 
terminal can be adjusted. Select it and drag 
the barrel so that it exits to the right, off the board. Click OK.

9 Auto Route dialog.
The Auto Route dialog launches; If we had a predetermined route for 
this wire, we could use existing clips or terminal connections, or drop 
clips from the Design Library, to Auto Route. Click OK to close this 
dialog.

10 Save the wire.
We will need another terminal connector. Exit the route sketch, and 
save the wire part as it currently exists.

11 Drop another connector.
While still editing the route sub-assembly, drop 
a different ring terminal on the other washer. 
This time use ring_term_awg-14-
16_awg-x 8 (the blue one).

Cancel the Insert Component dialog.

Rotate the connector so that the wire exits 
down.
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12 Edit the route.
Right click Route1 in the tree and select Edit Route.

13 Add to route.
Right click the CPoint of the new connector and select Add to route.

14 Auto Route.
Extend both wire segments to about the length of 
the strain relief. Right-click on one of the 
endpoints, and select Auto Route. Select the 
endpoint of the other wire segment to route to it.

The system auto routes a spline between the 
terminals. OK the Auto Route dialog, and exit the 
sketch.

15 Modify sketch.
Our wire bows through the bottom of the box, so 
will need some modification. Edit the sketch 
again.

Tip Section view is very handy for the next step.
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16 Spline point.
Add a spline point to manipulate the spline. Drag it back inside the box.

17 Branching.
Let’s assume there is another component, to be added later, that also 
needs a ground connection.

While still editing the sketch, return to the Wire route 1 view.
18 Add split point.

Right click on the route, and select Split Entities. 
Click on the spline near its midpoint. Right click, 
and return to Select mode.
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19 Add connector.
From the Design Library, drag and drop 
another ring terminal ring_term_18-
22_awg-x_6 (red) into the assembly. 

Answer Yes to the prompt.

Note When a routing connector is added while editing a routing sketch, it is 
added to the route automatically.

20 Make the connection.
Right-click on the new connector’s route 
line endpoint, and select Auto Route.

Route to the split point on the spline. A 
connecting route wire segment is added.

Close the sketch and save the assembly.

When the component is later added, the 
route sub-assembly can be edited, this 
connector mated to the component, and 
the route wire will update.

Adding Wire 
Information

The route has been formed, but we know very little about the wire 
itself. What is its gage and color, is it stranded or solid? Does it have a 
protective covering of any kind?

Using the Wire Library, we can assign a standard wire to the route and 
add other information as well.

The Cable / Wire 
Library

The Cable / Wire Library file contains data on the available wires. It 
can easily be generated in Microsoft Excel format and imported into 
the assembly as a .xml file.

Note SolidWorks Routing has a default cable / wire library (cable.xml) 
located in the design library\routing\electrical folder. 
For this exercise we will use a comparable file located in the Training 
Design Library.

The cable / wire library file, including importation of a custom file, will 
be covered in more depth in Lesson 11: Importing Electrical Data and 
Electrical Harnessing.

See SolidWorks Routing Help Topics in the Help menu for more 
information on the wire library and Excel file column format.
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21 Open the library.
From the Electrical toolbar, click Cable / Wire Library .

Browse to \\training design library\
routing\electrical and select cable.xml and Open.

In the menu, select Wire Library from the list. The available wires are 
displayed. 

Click OK.
22 Edit the route.

In order to add actual wire data to this route, we need to first edit the 
route.

Edit Wires After you define paths between connectors in the route sub-assembly, 
you can associate cable/wire data with the paths. The route diameter 
updates to reflect the diameter of the cables or wires you select for each 
path.
Where to find it:

While editing a route,

From the Electrical toolbar, click Edit Wires , 
From the main menu, select Electrical, Edit Wires....

See SolidWorks Routing Help Topics in the Help menu for more 
information.
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23 Edit Wires.
Select Edit Wires .

Here we can add or delete wires, or reorder 
segments.

24 Add a wire.
Click Add Wire . The 
Electrical Library dialog 
appears. Here we can select a 
wire specification to add. 
Let’s choose the 20g blue 
wire. Repeat to add a second 
blue wire. Click OK.

25 Wire added.
The new wires are shown in the list as magenta, 
indicating they are underdefined. We need to specify 
what portion of the route these wires are to follow.

26 Select path.
Choose the first wire in the list, and click Select 
path.

27 Pick the segments.
In the graphics view, 
pick the two indicated 
(highlighted green) 
segments, completing 
a path from the chassis 
to the circuit board. 
Then click OK.
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28 The other wire.
Repeat for the second 
wire, this time 
choosing the path from 
the chassis to the 
“floating” ring 
terminal. Click OK.

29 Edit wires data.
The Edit wires dialog now displays some valuable 
information:

The lengths of each wire
The wire specification (part number, as supplied 
in the cable / wire library)
The From- and To- component names 

There are no “pins” in these connectors, but if there 
were we could also specify pins for each wire.

Click OK, then exit the sketch.
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30 Updated display.
The display of our route has now 
updated with this new 
information.

The two single wires display as 
blue, and the proper size of 1mm 
diameter, per the specification.

The grouped, parallel run of the 
wires to the chassis is displayed 
as a generic gray color, and is 
noticeable larger in diameter.
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Lesson 11
Importing Electrical Data

and Electrical Harnessing

Upon successful completion of this lesson, you will be able to:

Import wire and component libraries, and assign to routes

Import a From - To list, and assign to wires to contacts

Generate a route from available data, with assorted hardware.

Create a Harness Drawing
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Harnessing Harnessing is the term given to the process of routing a bundle of 
wires or cables. A harness often involves branches to several different 
components and connection points. In the simplest terms, cable and 
wire routing refers to a single cable or wire, harnessing refers to more 
than one, and includes complete electrical data and a detailed Harness 
Drawing.

Importing 
Electrical Data

Electrical routes may use an optional cable / wire library, component 
library, and from - to list files, to specify vital electrical connection 
criteria. This electrical data would typically be supplied to the designer 
by the electrical engineer.

The Cable / Wire Library file consists of a table listing the wires 
available for any design or even in an entire plant inventory. The 
data in the table includes information such as part number, wire 
name, description, diameter, size (gage), and color.

Note SolidWorks supplies a default cable / wire library called cable.xml, 
located in the electrical directory.

The Component Library file is a similar table of connector 
components required for the route assembly. It includes information 
such as the part number, the maximum cable/wire/segment 
diameter for the connector, the part file location (path), its usage 
configuration, and a general description.

Note SolidWorks supplies a default component library called 
components.xml, located in the electrical directory.

The From - To List file is yet another table, with the data that 
assigns wires in the bundle to their respective pins on the 
appropriate connectors. It consists of data such as wire name, wire 
spec (part number), and connector and pin “from” and “to” 
designations. See from-to.xls in the Lesson 11 Case Study 
folder.

Note The Excel data files can contain many more columns of data, but they 
will not be used in routing.
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Cable / Wire 
Library

The Cable / Wire Library file contains data on the available wires.

See SolidWorks Routing Help Topics in the Help menu for more 
information.

1 Open cables-wires.xls in Microsoft Excel.
The cable / wire library file is located with the other files in the 
Lesson 11 folder for this lesson.

This Excel files contains information about the wires available to be 
used in our assembly.

For the sake of simplicity, this library has been limited just to little 
more than those wires that we will use in this example.

Note the data. Close the Excel file.

2 Open Signal control system.sldasm.
It is in the completed state from the previous lesson.
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Import Cable / 
Wire Library

Where to find it:

From the Main Menu, select Electrical, Import Data, Import Cable 
Library....

3 Import the wire library.
Select Electrical, Import Data, Import Cable 
Library....

Under Import Library, select the Browse button to 
find the file cables-wires.xls in the Lesson 
11 folder.

4 Set the .xml file name and location.
Under Cable/Wire library file, browse to the folder 
\\training design library\
routing\electrical to save the .xml file. 
Save it as cables-wires.xml.

5 Header Definitions.
These entries must agree with column headers in the 
Excel file for import to be successful. If more than 
one header is possible for the same item, separate 
with a semi-colon.

Tip Please refer to SolidWorks Routing Help Topics in the Help menu for 
more information on Excel file columns construction.

Click OK.
6 Confirmation.

The import is confirmed with a pop-up window. If there are import 
errors, they will be displayed here.

The library is now in .xml format.
7 Open the library.

From the Electrical toolbar, click Cable / Wire Library . First we 
see the data designated as Cable Library.
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In the menu, select Wire Library from the list. The available wires are 
displayed. Click OK.

Component 
Library

The Component Library file contains information on the connectors to 
be used in the route assembly.

See SolidWorks Routing Help Topics in the Help menu for more 
information.

8 Open connectors.xls in Microsoft Excel.
The connector library file is located with the other files in the Lesson 
11 folder for this lesson.

This Excel files contains information about the components to be used 
in our assembly. There are just two connectors to be used in this route 
assembly.

Note Important: If the training files were installed to a location other than 
C:\SolidWorks 2005 Training Files, the Libname path 
should be adjusted now.

Close the Excel file.

Import Component 
Library

Where to find it:

From the Main Menu, select Electrical, Import Data, Import 
Component Library....
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9 Import the component library.
Select Electrical, Import Data, Import Component 
Library....

Under Import Library, select the Browse button to 
find the file connectors.xls in the Lesson 11 
folder.

10 Set the .xml file name and location.
Under Component library file, browse to the folder 
\\training design library\
routing\electrical to save the .xml file. 
Save it as connectors.xml.

11 Merge library data.
If an existing library .xml file is chosen, the option to 
merge the files together into one is given.

12 Header Definitions.
These entries must agree with column headers in the 
Excel file for import to be successful. If more than one header is 
possible for the same item, separate with a semi-colon.

Tip Please refer to SolidWorks Routing Help Topics in the Help menu for 
more information on Excel file columns construction and file location 
for the SolidWorks part files.

Click OK.
13 Confirmation.

The import is confirmed with a pop-up window. If there are import 
errors, they will be displayed here.

The library is now in .xml format.
14 Open the library.

From the Electrical toolbar, click Component Library . The 
available components are displayed. This particular library contains 
only the components we need for this lesson. Click OK.



Lesson 11 SolidWorks 2005 Training Manual
Importing Electrical Data and Electrical Harnessing

152 From - To List

From - To List The From -To list contains information on how the connectors are to be 
joined and with which wires.

With a from-to list, you can import both the connection data and the 
component data into a new or existing route sub-assembly. 
Alternatively, you can import only the connection data (no component 
data) or only component data (no connection data). You are not 
required to use a from-to list - you can also enter the connection data 
and insert components manually when you create a route.

See SolidWorks Routing Help Topics in the Help menu for more 
information.

15 Open from-to.xls in Microsoft Excel.
Note the data, specific connection criteria for pins in the connectors.

Close the Excel file.

Import From-To 
List

Where to find it:

From the Electrical toolbar, click Import Electrical Data , 
From the main menu, select Electrical, Import Data, Import 
Electrical Data....
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16 Import the electrical data.
Select Electrical, Import Data, Import electrical 
Data....

Under Import From-To List, select the Browse 
button to find the file from-to.xls in the Case 
Study folder of this lesson.

Note that, under Set Libraries, you may also select 
alternate cable / wire and component libraries.

17 Header Definitions.
As with the libraries, these entries must agree with 
column headers in the Excel file for import to be 
successful. If more than one header is possible for 
the same item, separate with a semi-colon. 

Refer to SolidWorks Routing Help Topics in the 
Help menu for more detailed information on
From - To list headers.

Click OK.
18 Start the route.

With the import of From-To data, the route is 
initiated. Accept the default route name and 
template by clicking OK.

SolidWorks confirms that components can be 
placed. Click Yes to begin placement.
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19 Insert components.
The available components for 
this route appear in the Insert 
Components, Open 
documents list.

20 Drop components.
Select the first connector, J1, 
and bring it into the assembly 
graphics area. Look for the 
“peg-in-hole”  
SmartMate cursor, and click 
to drop on the lower hole of 
the left side.

Tip You do not need to “drag and drop” components by holding the left 
mouse button. Selecting them is all that is required.

21 Insert J2.
Repeat with J2 for the lower hole on the 
opposite side. Be sure the body is oriented 
toward the inside of the enclosure.

Note It is not necessary to insert all components at the beginning. You can 
resume insertion later by using Insert Components while editing the 
route.
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22 Insert J3 and J4.
Adjust the zoom to see the circuit 
board clearly.

Insert J3 on the second and J4 on 
the 5th receptacle as shown.

Note The connector DB9 male (J3 and J4) from the Training Design 
Library has a mate reference added to it that allows for easy 
SmartMates. The connector supplied in the SolidWorks Design Library 
does not have this mate reference by default, but it can easily be added.

23 Route Properties.
When all components are added, SolidWorks asks if 
you’d like to start modeling the route. Click Yes. 
The Route Properties dialog appears. Make certain 
Fix diameter is unchecked, and click OK.
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24 Auto Route.
Auto Route launches.

25 Route through clips.
Select View, Axes to 
turn on view of axes. It 
also may be helpful to 
turn on the axes 
selection filter.

Select the axis of the 
first lower clip; the 
route is propagated.

26 Continue
Finish the route 
through two 
more clips to the 
other 6-pin 
socket (J2) as 
shown, or 
improvise your 
own route.
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27 Split entites.
Right click on the route between the third clip 
and J2 select Split Entities.

Split the segment somewhere near the 
midpoint.

28 Add branches.
Right click on the endpoint of 
the route segment of the J4 
DB9 connector and select Auto 
Route. Route to the split point. 
Click OK to close the Auto 
Route dialog.

29 Route the other DB9 with 
clip.
Select the stub endpoint of the J3 
DB9. From the Design Library, 
select richco_hurc-4-01-
clip and drag it into the 
assembly.

Drag it over the hole in the bottom of the enclosure that’s just behind 
the connector.

Drop it; the cable Auto Routes from the connector through the clip. 
Close the Insert Components dialog.

30 Orient the clip.
It is important to note that, after dropping a clip from the Design 
Library, you can reorient the clip as desired from within the sketch. If 
necessary, zoom the display in to the clip, and drag it to the desired 
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orientation. The route will update after a move.

Additionally, if a later Add Wires operation changes the size of the 
route beyond the capacity of the clip, properly size-configured clips 
will update accordingly.

31 Complete the route.
Complete the route by using Auto Route to route from the clip 
segment to the split point.
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Edit Wires After you define paths between connectors in the route sub-assembly, 
you can associate cable/wire data with the paths. The route diameter 
updates to reflect the diameter of the cables or wires you select for each 
path.
Edit Wires is necessary to insure that the From-To and wire sizing 
information is applied to the harness appropriately.

Where to find it:

While editing a route,

From the Electrical toolbar, click Edit Wires , 
From the main menu, select Electrical, Edit Wires....

See SolidWorks Routing Help Topics in the Help menu for more 
information.

32 Edit Wires.
While still editing the route, click on
Edit Wires .

Here you can add or delete wires from the harness, 
or reorder the segments.

To add a wire, Click Add Wire . From the 
library, select a wire specification, Click Add, 
and OK. The new wire will appear as magenta in 
the list, indicating that the path is not defined. 
Next, select the wire and click Select path to 
specify which segments of the harness should 
carry this new wire.
To delete, select a wire from the list and click 
Delete Wire .
From-To Parameters will appear in the lower 
section when a wire is selected.

33 OK.
Clicking OK in the Edit Wires dialog does two 
things:

Incorporates all changes made in this dialog into the route.
Even if no other changes were made, OK will update all harness 
data per the From-To and cable/wire lists. This is necessary to 
resize all sections of the harness accordingly. Prior to this step, the 
harness sections were sized according to the CPoints on the 
connectors. When you click OK, you may see a subtle change in the 
section sizes.
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34 Exit and Save.
Exit the sketch and Save the cable part.

Electrical 
Attributes

Electrical Attributes displays relevant information about a particular 
harness segment, including the name and length of each wire in that 
segment.

Where to find it:

While editing a route, right-click a harness segment and choose 
Electrical Attributes.

See SolidWorks Routing Help Topics in the Help menu for more 
information.

35 Electrical Attributes.
Right-click on a segment of the route and select 
Electrical Attributes.

36 Wire Data.
Click on each of the wires in the Wire List in turn to 
see the Wire Data for that wire.

Click OK.
37 Save the top level assembly.

It is important to save the assembly before 
proceeding to Harness Drawing creation in order to 
insure propagation of all data, new and modified.
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Harness 
Flattening and 
Detailing

Harness flattening and detailing functionality is used to develop 2D 
harness manufacturing drawings from 3D electrical route assemblies.

In SolidWorks, the 2D drawing is generated directly from the 3D route 
sub-assembly.

Note Prior to creating or updating a Harness Drawing, it is important to 
Save the route assembly to be sure all changes are propagated.

Connector Views You can generate various 2D connector views for use in your Harness 
Drawing. For every unique connector in the harness, A SolidWorks 
block, generated from a drawing view of the connector, is inserted into 
the Harness Drawing near the segment endpoint where the connector is 
located.

The block is generated and inserted automatically into the Harness 
Drawing at creation or upon update if a SolidWorks drawing with a 
name that matches the connector file name exists in the folder 
\\SolidWorks\data\design library\routing\
electrical\harnessing\packages.

The source drawing need only have 2D geometry that has been con-
verted from a SolidWorks drawing view or from another CAD file such 
as DXF, DWG, etc.
See SolidWorks Routing Help Topics in the Help menu for more 
information.
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1 Open part J1 (socket-
6pindinmin) in its own window.
The part is a relatively simple mechanical 
representation of the connector. It does 
not have any true internal geometry, such 
as electrical contacts. It does, however, 
have a mate reference and an electrical 
CPoint. Close the part.

2 Open the block source drawing.
In the directory \\training design 
library\routing\electrical\
harnessing\packages, open the 
drawing file
socket-6pindinmin.slddrw.

This drawing file contains simple 
geometry that will represent the 
connector when imported into our 
Harness Drawing in the form of a block.

The block can be customized with notes 
or other text, or with additional geometry.

Notice the text within the central arc, specifying pins 1 through 6. 
These notes determine the placement of wire color graphics, which 
display the colors of wires in connector pins or cavities in the harness.

Note Drawing views themselves will not be brought into the Harness 
Drawing. All graphical data must be converted to lines and arcs using 
sketch tools.

See SolidWorks Routing Help Topics in the Help menu for more 
information on connector blocks.

Close the file.

Harness Drawing The Harness Drawing takes the 3D mechanical data of the route sub-
assembly and applies it to a 2D harness manufacturing drawing, 
flattened and with detail.

See SolidWorks Routing Help Topics in the Help menu for more 
information.

3 Harness Drawing size.
If not already, return to the main assembly, Signal Control 
System.
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From the Wiring menu, select System Defaults.... 
Here we select the size of our Harness Drawing. Be 
sure Update reports automatically is checked, and 
choose 4FT x 4FT from the list, then click OK.

4 Create the drawing.
From the Wiring menu, select Wiring Summary.... 
The list displays both route sub-assemblies in this 
assembly. Select RouteAssy1-Signal 
Control System, and click Open Drawing.

A new drawing file,
RouteAssy1-Signal control system-1.SLDDRW, is created 
and saved automatically.
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5 Arrange segments and add relations.
The Harness appears in a default orientation. Arrange the segments to 
your liking or for visibility or logical manufacture.

All segments are sketch lines that can be given relations and 
constraints:

First, add a Horizontal relation to the long segment on the left.
Next, switch on the Point selection filter, and Fix the 4-way 
junction point.

Finally, spread the branches and lock them in place using either Fix 
constraints or dimensions.

6 The connector blocks.
Zoom the display in on one of the block 
images. The block can be moved or rotated as 
desired.

The connector block also displays pin / wire 
data, in color.
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7 Show wires on selection.
Select Wiring, Project, Properties..., and check 
Show wires on selection, then click OK.

Selection of endpoints will then 
display what wires are present 
at that connector endpoint.

Other Data Other vital manufacturing data that can be added to the Harness 
Drawing include Part Tables, a BOM, and Circuit Summary. Additional 
components, including coverings and terminals, may also be added to 
the Harness.

8 Insert Part Tables.
Select Wiring, Edit, Parts..., or click Edit Parts  on the Wiring 
Toolbar.

Select J1 from the list, and click Insert Part Table.
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You can add Part Tables for the other connectors in the assembly as 
well, and reposition them as needed.

9 Add Wiring Reports.
Wiring Reports include Bill of Materials (BOM) and Circuit Summary 
tables.

Select Wiring, Reports.... Check both the Circuit Summary and 
Harness Bill Of Materials check boxes. Click OK.

The tables are added in the default (lower left) location, but can be 
repositioned or resized as desired.

10 Other parts in the Harness.
Various other components may be required to complete this Harness, 
including, but not limited to, protective coverings, contact terminals, or 
seals. When added, the Harness BOM will update.
See SolidWorks Routing Help Topics in the Help menu for more 
information on the Harnessing Libraries.
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11 Add Covering.
Select Wiring, Edit, Covering....
From the Library name list, let’s add Cor Tube .5in BLK and give 
it the custom Name tubing1. Select the short segment to the J4 DB9 
connector, and click Create/Edit.
Add other coverings as you see fit. Coverings with colors will change 
the color of the Harness segment.
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12 Add Terminals.
Select Wiring, Edit, 
Terminals....
It is typical to add many 
more terminals to the 
assembly than is needed 
to account for drops, 
losses and breakage. 
Several terminal types 
are supplied in the 
Terminals Library.

Lets add 25 of 66506-
9 and 25 of 207683. 
Enter 25 in Number to 
insert, and click Insert. 
25 appear as 
Unassigned. Repeat 
for the other terminal. 

Click OK.

The BOM updates accordingly.
13 Edit Wires.

By editing the wires in the Harness, we can assign 
terminals to the wire ends.
Select Wiring, Edit, Wires..., or click Edit Wires 

 on the Wiring Toolbar.

14 Assign terminals.
Let’s assume the 6 pin (J1 and J2) connectors 
require 66506-9 terminals, and the DB9 (J3 and 
j4) connectors require 207683 terminals.

As you select each wire in the list, you can see its 
From- and To- connection info. Under Terminals 
connected, add the appropriate terminal to each.

When complete, click OK.
15 Edit Terminals dialog.

Return to Edit Terminals. The dialog displays some 
of the terminals as Assigned. Close the dialog.

Save the drawing.
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Editing Libraries Libraries of Harnessing parts can be edited from within SolidWorks.

Where to find it:

Select Wiring, Library, Edit...,
or click Edit Library  on the Wiring Toolbar.

16 Edit Library.
From within this dialog you can Edit, Create or 
Delete entries in any of the Harnessing component 
library .xml files.

17 Existing covering.
Let’s look at wire coverings. Under Choose Type, select Covering. 
From the list, find Loom .5in YEL.
Under Properties, we can see the properties for this covering.

18 Create new.
Under Property Name and Value, change Part 
name to Loom .5 in Green.
Under Name, type in Color.
Under Value, type in GRN.

Click Create/Edit.

This new green loom covering will now be available 
for future use.

Add other property names and values as desired to complete the 
description.

Click OK, Save and Close the drawing.
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